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CHAPTER 1

Setting Up Your 
Avid Xpress DV System

This chapter describes how to set up your Avid Xpress DV system. It 
consists of the following sections:

• Check List for Setting Up Your System

• Turning On Your Equipment

• Preparing Your Drives

• Installing Avid Xpress DV Software

• Installing AvidNet Transfer Tool Software

• Installing EDL Manager

• Creating an Emergency Repair Disk

• Installing the Avid Xpress DV Tutorial Files

• Turning Off Your Equipment
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Check List for Setting Up Your System

The check list in Table 1-1 lists the tasks you need to complete before 
you can use your Avid Xpress DV system.

Table 1-1 Check List for Setting Up Your System

To See

Set up your computer hardware: 
computer, monitor, mouse, keyboard, 
and speakers 

Instructions shipped with the
computer

Connect your optional external drives Appendix A

Install the application key and printer Appendix A

Connect your camera or video deck 
(you can connect these after you install 
the software if you prefer)

Appendix A

Turn on your equipment “Turning On Your Equipment” on 
page 15

Prepare your drives “Preparing Your Drives” on page 16

Install Avid Xpress DV software “Installing Avid Xpress DV 
Software” on page 24

Create an emergency repair disk “Creating an Emergency Repair 
Disk” on page 34

Install Avid Xpress DV tutorial files 
(optional)

“Installing the Avid Xpress DV 
Tutorial Files” on page 35
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Turning On Your Equipment

After you have connected your equipment, turn on the various 
components. If you have connected external drives, you need to shut 
down and restart your computer before the computer can detect and 
use the external drives. 

If any part of your system fails to turn on, make sure its electrical cord 
is plugged snugly into an appropriate electrical outlet or power strip. 
For more information, see the instructions for setting up your 
computer hardware.

c If you fail to follow the proper sequence for starting your system, 
you could damage your computer or storage drives.

Turn on the components in the following order:

1. External media drives: Your system might include one or more 
external media drives. Turn on the drive or drives before starting 
the computer. Allow 10 to 15 seconds for the drives to spin up to 
speed before starting your computer.

2. Other peripheral hardware: Turn on all other peripheral units, 
such as monitor and speakers. If you have connected a camera, 
transcoder, or deck, turn them on now. 

3. Computer: 

a. Turn on your computer.

The computer goes through a self-check routine, and the 
Windows NT startup screen appears.

For information on your 
Windows NT features, 
such as the desktop and 
icons, see your 
Windows NT 
documentation.

b. Press Ctrl+Alt+Delete and log on.

The Windows NT desktop appears.
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c To avoid system damage, do not disconnect or turn off the external 
media drives while the computer is on.

Preparing Your Drives

To use Avid Xpress DV software on a Windows NT system, you need 
to partition and format the drives properly. Partitioning divides a drive 
into sections, and formatting places a file system on each partition. 

Your computer contains two internal disk drives. One drive is already 
partially partitioned and formatted (see “Checking Your Internal 
Drives” on page 18). This partition contains the Windows NT 
operating system. That’s why the Windows NT operating system 
appears automatically when you turn on the computer.

This section includes the following information:

• Overview of Partitioning

• Supported File Systems

• Checking Your Internal Drives
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• Creating Primary Partitions

• Formatting Partitions

• Creating a Disk Configuration Floppy Disk

• Testing Drives on Windows NT Systems

Overview of Partitioning

Windows NT allows you to create multiple partitions on a single 
physical drive as a way to manage projects and files. The following are 
two ways you can partition your drives. 

The letters G through J 
used are examples only.

• You can partition your drive as one primary partition, having the 
partition represented by a drive letter. 

• You can have up to four primary partitions per drive. Each 
partition is assigned a drive letter and cannot be further 
subdivided.

For specific recommendations for partitioning your drives, see 
“Creating Primary Partitions” on page 20. 

G

One partition

Drive G

G H I J

Four partitions

Drives G – J
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n You can also create a partition across more than one drive, which is
called striping drives. You do not need to stripe drives when you use 
Avid Xpress DV. See the Windows NT documentation for striping 
information.

Supported File Systems

Windows NT supports two file systems: the File Allocation Table 
(FAT) and the New Technology File System (NTFS). FAT is primarily 
used when backward compatibility is needed on operating systems 
such as MS-DOS® or Windows NT. In general, FAT file systems should 
be limited to a 2-GB partition size to maintain this backward 
compatibility. NTFS affords the user security, compression, and other 
file recovery features. Drives employing NTFS support partitions of 
any size. Avid recommends that you choose NTFS when you partition 
your disk drives. 

c One of your internal disk drives has a partition (designated drive C) 
that contains the Windows NT operating system stored on a FAT file 
system. You should not reformat this partition unless you need to 
rebuild your system disk drive.

Checking Your Internal Drives

Your computer contains two internal disk drives. The first drive has a 
2-GB partition that is formatted with a FAT file system. This partition 
is your system or boot drive, which is designated drive C in the factory 
default configuration. The remaining portion of this drive needs to be 
partitioned and formatted before you install Avid Xpress DV software. 

The second drive is intended to be used as a media drive (see “Media 
Files” on page 40). You need to partition and format this drive also.
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To check if you need to partition and format these drives:

1. Start Windows NT 4.0 and log in to an account with 
administrative privileges. 

2. Click the Start button, point to Programs, point to Administrative 
Tools, and select Disk Administrator. The Disk Administrator 
window opens.

3. Look at Disk 0 and Disk 1. 

Your Disk 0 should look similar to Disk 0 in Figure 1-1. The figure 
shows Partition C on Disk 0, with a stripe across the top, with 
IBM® Preload and a FAT file system.

c You should not partition and format the partition that contains the 
Windows NT operating system. In the factory default configuration, 
this partition is designated drive C, as shown in Figure 1-1.

Any remaining portion of Disk 0 or Disk 1 that shows Free Space 
(as shown in Figure 1-1) needs to be partitioned and formatted.

Figure 1-1 Example of Local Disks 

9420 MB

18428 MB
18 MB

Needs partitioning and formattingAlready partitioned and formatted
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Creating Primary Partitions

To create a primary partition:

1. Start Windows NT 4.0 and log in to an account with 
administrative privileges. If you do not have administrative 
privileges, see your system administrator to get privileges.

2. Click the Start button, point to Programs, point to Administrative 
Tools, and select Disk Administrator. The first Disk Administrator 
window opens.

3. From the Windows NT Disk Administrator, use the pointer to 
select the portion of the disk on which you are going to create one 
or more primary partitions.

4. From the Partition menu, choose Create.

The Create Primary Partition dialog box appears.

5. Choose the size of the primary partition by typing a number or by
clicking the up or down arrow. 

Avid recommends creating a second partition on the first internal 
drive (Disk 0), using all the remaining space. Avid also 
recommends creating one large partition on the second internal 
drive (Disk 1). In both cases, use the maximum size for the 
partition.
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If you want to create multiple partitions, you can divide the 
maximum size of the partition by the number of partitions (up to 
4). Type that number in the Create partition of size text box.

6. Click OK to create the primary partition.

7. If you are formatting multiple partitions, repeat steps 3 through 6 
to create up to four primary partitions. 

8. From the Partition menu, choose Commit Changes Now.

The first Confirm dialog box appears.

9. Click Yes.

The following Disk Administrator dialog box appears.

10. Click OK. 

Formatting Partitions

To format the primary partitions you created:

1. From the Windows NT Disk Administrator, use the pointer to 
select the primary partition that you are going to format.
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2. From the Tools menu, choose Format.

The Format window opens.

3. Choose NTFS File System.

4. Type a Volume Label Name that helps you define that partition.

You can enter up to 14 characters.

5. Select Quick Format.

6. Click Start to begin formatting.

The Format warning dialog box appears.
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This warning refers only to the new partition, not previously 
formatted partitions.

7. Click OK.

The Format Complete dialog box appears after formatting and 
tells you the total disk space and the total disk space available on 
the volume. 

8. Click OK.

9. Repeat steps 1 through 8 until you have formatted all of the 
primary partitions you created.

Creating a Disk Configuration Floppy Disk

You should now save the new disk configuration on a floppy disk.

To create a configuration floppy disk:

1.  Start Windows NT 4.0 and log in to an account with 
administrative privileges. If you do not have administrative 
privileges, see your system administrator to get privileges.

2.  Click the Start button, point to Programs, point to Administrative 
Tools, and select Disk Administrator. The first Disk Administrator 
window opens.

3.  Choose Configuration from the Partition menu and select Save. 

4.  A dialog box appears asking you to insert a floppy disk into the 
floppy drive. 

5.  Click Yes.

Store the configuration floppy disk in a safe, dry, static-free location.

n Whenever you change your disk configuration, create a new configuration 
floppy disk.



24

Testing Drives on Windows NT Systems

The Windows NT operating system contains a disk-checking feature in 
the Properties section of each drive and a program named CHKDSK. 
For information about how to use this feature and program, see the 
Windows NT documentation. 

Installing Avid Xpress DV Software

This section describes how to install the Avid Xpress DV application 
and its related components from the installation CD-ROM. 

n In order to install or remove the application software, you need to use an 
account with administrative privileges.

c The following third-party software applications have been modified 
to work properly with Avid software: RealProducer G2, LSX-MPEG, 
ASF NetShow™, and QuickTime®. Downloading newer versions of 
these applications before they are supported by Avid might cause 
problems. Avid recommends not updating any of these applications 
until they are officially supported by Avid. Check the Customer 
Service section of the Avid Web site at www.avid.com.

Installing Avid Xpress DV Software and All Components

To install the Avid Xpress DV software and all related components: 

1. Quit all Windows NT applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.
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If the installation program doesn’t start automatically:

a. Double-click the My Computer icon.

b. Double-click your CD-ROM drive icon. 

c. Double-click the Launch icon. 

The opening window of the installer opens. 

3. In the opening window, click Installers. 

4. Click Install Avid Xpress DV. 

n If you have not partitioned and formatted the second internal disk drive (in 
addition to drive C) or additional external drives, a message appears. This 
message informs you that you need at least two partitions to run 
Avid Xpress DV. One partition is the boot drive (drive C), and the other 
partition is used to store media. For instructions on partitioning and 
formatting drives, see “Preparing Your Drives” on page 16.

If you have previously installed Avid Xpress DV, the Welcome 
window for the Setup Maintenance program opens. Follow the 
steps in “Modifying, Repairing, or Removing Avid Xpress DV” 
on page 29

5. In the Welcome window, click Next.

6. In the License Agreement window, read the agreement, and then 
click Yes to accept the terms of the agreement.

7. In the Choose Destination Location window, accept the default 
path for the application folder (on drive C) by clicking Next. The 
default path is:

C:\Program Files\Avid\Avid Xpress DV

8. In the Setup Type window, select an option:

• Select Typical to install all components. This is the 
recommended installation.

• Select Custom to select the components you want to install. 
See “Performing a Custom Installation” on page 28.
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9. After you have selected an option, click Next.

The AVX_Plug-In Location window opens and displays the 
default destination as:

C:\Program Files\Avid\AVX_Plug-ins

10. Click Next to accept the default path.

11. In the Application Data Location window, indicate a location for 
the application files (project folders and user folders). 

n Avid recommends that you install these files on a drive or partition other than 
drive C.

To change the default path:

a. Click the Browse button.

b. In the Path text box, type:

drive:\Avid\Avid Xpress DV 

c. Click OK. 

A message asks if you want to create the folder.

d. Click Yes.

12. Click Next.

The installation begins. During the installation, you see 
installation programs for a series of components. For 
RealProducer G2, a Welcome window opens.

a. Click Next

b. In the License Agreement window, click Yes.

c. In the RealProducer G2 Setup Complete window, click Finish.

When the Avid Xpress DV installation is complete, another Setup 
Complete window opens and asks if you want to restart the 
system. 

13. Click Yes, and then click Finish.
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Installing Selected Components

You can install some Avid Xpress DV components separately. These 
components, which create movies for Internet distribution, include:

• RealProducer G2

• LSX-MPEG

• ASF NetShow

• QuickTime

To install a selected component:

1. Quit all Windows NT applications.

2. Insert the Avid Xpress DV Installation CD-ROM into the CD-ROM 
drive.

If the installation program doesn't start automatically:

a. Double-click the My Computer icon.

b. Double-click your CD-ROM drive icon. 

c. Double-click the Launch icon. 

The opening window of the installer opens.

3. In the opening window, click Component Installers. 

4. Select the component you want to install and follow the on-screen 
instructions.
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Performing a Custom Installation

You can perform a custom installation to install particular files from 
the installation CD-ROM. Table 1-2 lists the components available 
when you use the Custom option of the Avid Application Installer.

To perform a custom installation:

1. Follow steps 1 through 7 in the procedure “Installing Avid Xpress 
DV Software and All Components” on page 24.

2. In the Setup Type window, click Custom and then click Next.

3. In the Select Components window, click the check boxes next to 
the components you want to install. A check mark indicates the 
component is selected. 

4. After you have selected the components to install, click Next.

5. In the Application Data Location window, indicate a location for 
the application files (project folders and user folders). 

n Avid recommends that you install these files on a drive or partition other than 
drive C.

Table 1-2 Custom Installation Components

Component Description

Avid Xpress DV Installs the application and all the necessary 
supporting files, except the Help files.

Help files Installs the appropriate Help files.
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To change the default path:

a. Click the Browse button.

b. In the Path text box, type:

drive:\Avid\Avid Xpress DV 

c. Click OK.

A message asks if you want to create the folder. 

d. Click Yes.

6. Click Next. 

The installation begins. When the installation is complete, a 
message asks if you want to restart the system. 

7. Click Yes, and then click Finish.

Modifying, Repairing, or Removing Avid Xpress DV

If you have installed Avid Xpress DV and need to reinstall or remove 
it, you use the Setup Maintenance program.

To modify, repair, or remove Avid Xpress DV:

1. Quit all Windows NT applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

If the installation program doesn’t start automatically:

a. Double-click the My Computer icon.

b. Double-click your CD-ROM drive icon. 

c. Double-click the Launch icon. 

The opening window of the installer opens. 

3. In the opening window, click Installers. 

4. Click Install Avid Xpress DV. 
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The Welcome window for the Setup Maintenance program opens. 
It presents three options:

• Modify: Select this option to add new program components or 
remove currently installed components. 

n If you choose to remove currently installed components, this option does not 
remove registry entries or icons in the Start menu. To fully uninstall 
Avid Xpress DV, select the Remove option.

n If you want to remove Avid AVI Codec, RealProducer G2, LSX-MPEG 
(Ligos), ASF NetShow, or QuickTime, use the Add/Remove Programs dialog 
box. To access Add/Remove programs, click the Start menu, point to Settings, 
click Control Panel, and double-click the Add/Remove Programs icon.

• Repair: Select this option to reinstall the components that you 
previously installed.

• Remove: Select this option to completely uninstall all 
components of Avid Xpress DV.

5. Select one of the three options and click Next.

• If you selected Modify, the Select Components window opens. 
Components that are already installed are selected. Select the 
new components you want to install. The installation 
proceeds, as described in steps 12 and 13 in “Installing Avid 
Xpress DV Software” on page 24.

c If you deselect an installed component, the installation program will 
remove the component from the Avid Xpress DV system.

• If you selected Repair, the installation proceeds, as described 
in steps 12 and 13 in “Installing Avid Xpress DV Software” 
on page 24.

• If you selected Remove, a message box asks you to confirm 
that you want to delete the files. Click OK. When the 
Maintenance Complete window opens, click Finish. Click Exit 
to quit the installation program.
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Installing AvidNet Transfer Tool Software

The AvidNet™ Transfer Tool is an application that allows you to 
transfer media and files over a network. For information on using the 
AvidNet Transfer Tool, see the AvidNet Transfer Tool User’s Guide, 
available on the Avid Xpress DV Online Publications CD-ROM, and the 
Avid Xpress DV Release Notes.

n Before installing the AvidNet Transfer Tool, you should first install 
Avid Xpress DV. The installer can find media drives already configured on 
the system only if you install the AvidNet Transfer Tool after you install 
Avid Xpress DV.

To install the AvidNet Transfer Tool software:

1. Quit all Windows NT applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive. 

3. If the installation program doesn’t start automatically:

a. Double-click the My Computer icon.

b. Double-click your CD-ROM drive icon.

c. Double-click the Launch icon.

The opening window of the installer opens.

4. In the opening window, click Installers. 

5. Click Install AvidNet. 

6. In the Welcome window, click Next.

7. In the License Agreement window, read the agreement, and then 
click Yes to accept the terms of the agreement.

8. In the Choose Destination Location window, accept the default 
path for the application folder (on drive C) by clicking Next. The 
default path is: 

C:\Program Files\Avid\AvidNet 
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If you have installed the AvidNet Transfer Tool previously, a 
dialog box asks you if you want to uninstall files. Click Yes, and 
then follow the on-screen instructions.

9. Select a media drive for Incoming Media Files and click Next.

10. Select a destination location for Incoming Files and click Next.

If you select a location on drive C, a message tells you that you 
need to select an NTFS drive for compatibility with Macintosh 
files. For compatibility, click No, select a drive other than drive C, 
and click Next.

11. Select a destination location for Incoming Compositions and click 
Next.

12. Select a directory in which to place the AvidNet log file and click 
Next.

13. In the Enter Information window, leave the selection as No BWM 
Server and click Next. 

14. In the Start Copying Files window, review the current settings. If 
you agree with those settings, click Next to copy the files.

15. Click Yes to view the ReadMe file when prompted in the Question 
window, or click No to complete the setup.

16. In the Setup Complete window, click Yes to restart the computer, 
and then click Finish.
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Installing EDL Manager

EDL Manager is an application that allows you to generate EDLs (edit 
decision lists) from sequences exported from any Avid video-based 
editing product. For information on using EDL Manager, see the 
Avid EDL Manager User’s Guide, available on the Avid Xpress DV Online 
Publications CD-ROM. 

You can install EDL Manager on another computer. For example, you 
might want to install EDL Manager on a portable computer that you 
can take with you to an online suite, or on a computer located at the 
online suite.

To install EDL Manager:

1. Quit all Windows NT applications.

2. Insert the Avid Xpress DV application CD-ROM into the CD-ROM 
drive.

3. If the installation program doesn’t start automatically:

a. Double-click the My Computer icon.

b. Double-click your CD-ROM drive icon.

c. Double-click the Launch icon.

The opening window of the installer opens.

4. In the opening window, click Installers.

5. Click Install EDL Manager.

If you have previously installed EDL Manager, the Setup 
Maintenance Program window opens. Follow the steps in 
“Modifying, Repairing, or Removing Avid Xpress DV” on 
page 29.

6. In the Welcome window, click Next.
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7. In the License Agreement window, read the agreement, and then 
click Yes to accept the terms of the agreement.

8. In the Choose Destination Location window, accept the default 
path for the application folder (on drive C) by clicking Next. The 
default path is:

C:\Program Files\Avid\EDL Manager

9. In the Setup Type window, select Typical and click Next.

The installation proceeds and the Setup Complete window opens.

10. Do one of the following:

• To quit the installation procedure and start EDL Manager, 
select Launch EDL Manager Now, and click Finish.

• To quit the installation procedure without starting 
EDL Manager, deselect Launch EDL Manager Now, 
and click Finish.

Creating an Emergency Repair Disk

Avid recommends that you update the emergency repair disk (ERD) 
each time you add or change hardware or software to your system. 
The ERD is a floppy disk that contains the latest information about 
your system configuration. It is needed in case your system is 
damaged and you need to rebuild your system from scratch. If you 
have a problem, search for Emergency Repair Disk in the Windows NT 
Help.



35

To create a repair disk:

1. Start Windows NT 4.0 and log in to an account with 
administrative privileges. If you do not have administrative 
privileges, see your system administrator to get privileges.

2. Click the Start button and select Run. The Run window opens. 

3.  Type rdisk /s and press the Enter key. 

4.  Follow the instructions to create a repair disk. 

 Store the emergency repair disk in a safe, dry, static-free location. 

Installing the Avid Xpress DV Tutorial Files

The Avid Xpress DV Tutorial CD-ROMs contain all the files you need 
for the tutorial chapters of this guide, including DV media that is 
ready for you to use. The tutorial files are shipped on two CD-ROMs, 
in either NTSC or PAL format.

You will need approximately 1 GB of free space available on a media 
drive. It takes approximately 10 minutes to complete the installation 
program.

To install the tutorial files:

1. Quit all Windows NT applications.

2. Insert Avid Xpress DV Tutorial CD 1 into the CD-ROM drive.

If the installer doesn’t start automatically after you insert the 
application CD-ROM, do the following:

a. Double-click the My Computer icon.

b. Double-click the CD-ROM to open it. 

c. Double-click the Launch icon to start the installer. 

The opening window of the installer opens.
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3. In the opening window, click Installers.

4. Click Install Tutorial.

5. In the Welcome window, click Next.

6. In the Choose Destination Location window, accept the default 
path and click Next.

This path should add the Avid Projects folder to the path you 
selected for application data when you installed Avid Xpress DV. 
See “Installing Avid Xpress DV Software” on page 24. 

7. In the Select a Drive window, select a drive for the tutorial media 
and click Next.

The installation begins. When the installation is finished for CD 1, 
a message asks you to insert Avid Xpress DV Tutorial CD 2 into 
the CD-ROM drive.

8. Insert CD 2 into the CD-ROM drive and click OK. 

9. When the installation is complete, the Setup Complete window 
opens. Click Finish.

10. Click Exit to quit the installation program.

The installation program copies the following folders to your system:

• Introducing Avid folder: This folder contains the project and bins 
you need for the tutorial and is copied into the Avid Projects folder 
on your hard drive.

• OMFI MediaFiles folder: This folder contains the media files you 
need for the tutorial and is copied to a media drive.
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Turning Off Your Equipment

When you are finished using your system and want to turn it off 
completely, follow these steps to avoid damaging your computer or 
media storage drives. Make sure to quit Avid Xpress DV before 
turning off your equipment. See “Closing the Project and Quitting 
the Application” on page 68.

To turn off your equipment:

1. Choose Shut Down from the Start menu.The Shut Down Windows 
dialog box appears.

2. Select the Shut down the computer option and click Yes.

3. When the system displays a message telling you it is safe to turn 
off your computer, press the Power button on the computer.

4. Turn off your speakers and monitors.

5. Turn off each external media drive.

6. Turn off all other hardware.

c Never remove external media drives from your Avid Xpress DV 
system when it is turned on. Shut down the computer before you 
move drives.
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CHAPTER 2

About Avid Xpress DV

This chapter explains the basic concepts and terminology that you 
need to be familiar with to edit video with Avid Xpress DV. These 
concepts include:

• About DV

• Nonlinear Editing with Avid Xpress DV

• Avid Xpress DV Terms and Concepts

• The Avid Xpress DV File System

• Project Workflow
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About DV

The initials DV in the product name Avid Xpress DV stand for digital 
video. More specifically, they refer to digital video that is transferred 
through equipment conforming to IEEE Standard 1394. This 
equipment (cameras, video and audio decks, cables, connectors, and 
processing boards) is sometimes referred to as FireWire® or I-Link™. 
DV connections let you transfer digital data (both video and audio) 
directly from a DV camera to a digital, nonlinear editing system with 
no conversion losses. DV technology simplifies the process of bringing 
footage from your camera into your Avid Xpress DV system, and gives 
you high-quality video at low cost.

Nonlinear Editing with Avid Xpress DV

In traditional video editing, you electronically copy (dub) video and 
audio footage from a source tape to a master tape. This process is 
tedious, however, and it is difficult to make changes to your work. 

By contrast, when you edit with Avid Xpress DV, you don’t have to 
dub footage onto a master tape. Instead, you manipulate Avid Xpress 
DV clips, which are segments of the media that contain pointers to 
your digital audio and video files. Avid Xpress DV allows you to 
experiment with every edit you make. You can trim, move, delete, 
duplicate, or modify individual frames or entire segments, and 
immediately see the results. This type of editing is called nonlinear 
because you are not limited by the traditional video editing need to 
dub one shot after another.
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Avid Xpress DV Terms and Concepts

This section explains the following terms and concepts to help you 
understand the Avid Xpress DV editing process:

• Media Files

• Clips

• Subclips

• Sequences

• Bins

• Projects

• The Attic Folder

• Programs

Media Files
Media files store source 
material.

When you record source material from a camera or deck, or when you 
import computer graphic files into your Avid Xpress DV project, the 
material is saved in media files on your system’s media drive or drives. 
One media file is created for each track of video or audio. For a video 
with a stereo sound track, three media files are created: one track of 
video and two tracks of audio. Media files are stored in the OMFI 
MediaFiles folder; and each media drive has its own OMFI MediaFiles 
folder.

n Even though your media files contain the actual source material for the 
program, you never manipulate the media files directly. Instead, you move, 
copy, and edit clips, subclips, and sequences, which are pointers to the media 
files.



41

Clips
Clips point to media 
files.

When you record media, Avid Xpress DV creates another file, called a 
master clip, on your system’s internal drive. The master clip is simply a 
pointer to its corresponding media file, which is located in the OMFI 
MediaFiles folder on a media drive. A media drive can be inside the 
computer (an internal media drive) or outside the computer (an external 
media drive).

While editing your video, you create other clips, such as graphic clips 
and effects clips. You make your edits by modifying clips, and the 
corresponding media files remain unchanged. This feature allows you 
to easily create and undo edits without destroying your original 
material.

Because you work with clips instead of media files, you can create 
virtually unlimited versions of a program without creating multiple 
copies of the source material, which is stored in extremely large files.

Subclips
Subclips are sections 
that you mark within 
clips.

Subclips are sections of clips that you want to use in your program. You 
create a subclip by marking IN (start) and OUT (end) points in a clip, 

Video deck

Master clip

Media drive

OMFI
MediaFiles
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pressing and holding the Alt key, and dragging the clip to the bin. The 
subclip is composed of the material between the IN and OUT points.

c A subclip points to a media file’s master clip. You must not delete 
the master clip from which a subclip was created. If you delete the 
master clip, you will lose the information in the subclip.

Sequences
A sequence is a
program created from 
one or more clips and 
subclips.

You can join different clips and subclips to create a sequence. A 
sequence can include edited material from master clips and subclips, 
new clips created when you add effects during the editing process, 
and material from other sequences. 

Master

Subclip  

clip

Sequence

Subclip

Master clip

Sequence

Handle

IN point OUT point

Handle
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A sequence is composed of marked material from clips, subclips, and 
other sequences. The material outside the IN and OUT points remains 
in the media file’s master clip. These segments of material are called 
handles. Handles are important; you need them to trim cuts and create 
transition effects between segments. For more information about 
trimming cuts, see “Trimming” on page 127. For more information 
about transition effects, see “Effects Editing” on page 137.

Like clips and subclips, a sequence contains pointers to media files, 
which are stored in the OMFI MediaFiles folder. If you delete a clip 
used to create a sequence, the sequence still displays the media, 
because the sequence contains its own pointers to the media files.

Bins
You organize your 
footage in bins.

Clips, subclips, and sequences are organized and stored in bins. 
Traditionally, a bin is a place where film editors store reels of film. In 
Avid Xpress DV, bins represent a database for organizing the material 
for a project.

Projects
A project consists of one 
or more bins.You edit 
within a project. 

You gather the material you need to create a program in a project. Each 
project contains information about bins, clips, subclips, sequences, and 
the program in the Timeline. You might have several projects on your 
system, but you can work on only one project at a time.

Sequence

Clip

Subclip

OMFI
MediaFiles
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The Attic Folder
For a complete 
description of retrieving 
bins from the Attic 
folder, see the Avid 
Xpress DV User’s Guide 
or Help.

Avid Xpress DV saves copies of your current project and its bins at 
regular intervals and whenever you save or close a project or bin. 
These auto-save files are stored in the Attic folder at the top level of the 
internal hard drive. If you lose work due to a power outage or system 
error, open the Attic folder and look for a project or bin of the same 
name with the file name extension.bakxx, where xx is the version 
number. For example, the first backup file for the bin Rough Cut 
would be named Rough Cut.bak01. Later versions would be named 
Rough Cut.bak02, Rough Cut.bak03, and so on.

Programs

A program consists of one or more sequences. You can use clips, 
subclips, and sequences to build a program. A program is your final 
creation; you can output your program to tape, CD-ROM, or the Web 
when you are finished.
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The Avid Xpress DV File System

The following illustration shows the different kinds of Avid Xpress DV 
files and where they are stored. The Avid Xpress DV application folder 
is stored on your computer’s internal hard drive. The Avid Projects 
folder is also stored on an internal drive; the location varies, 
depending on your installation. An OMFI MediaFiles folder is stored 
on each media drive. Media files must be stored on a separate, Avid-
approved media drive that is guaranteed to be fast enough to support 
video playback.

For complete 
information about 
folders and files, see the 
Avid Xpress DV User’s 
Guide or Help.

Media drive

Avid Avid

Project

Project

Bin A Bin B
Supporting

Avid Xpress DVSettings

Help

OMFI
MediaFiles

 ProjectsXpress DV

Files
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Project Workflow

The following sections illustrate the four stages of a typical 
Avid Xpress DV project: starting a project, preparing to edit, editing a 
sequence, and generating output.

Complete procedures for each stage are included in the printed 
manuals, online books, and Help.
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Starting a Project

1. Turn on your 
equipment in the 
correct order and start 
the software. (Speakers 
and external media 
drives are optional.)

2. Select or create a new 
user and project: the job 
that will result in one or 
more finished sequences.

3. Create and organize 
bins.

4. Back up your project 
on a regular basis.

Starting a project involves the following steps:

 

2. Select or create a user and project.

3. Create and organize bins.

4. Back up the project.

1. Turn on and start your Avid system.
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Preparing to Edit

1. (Optional) Import 
your log files into the 
bins, or log the material 
manually.

2. Record your DV 
footage, creating media 
files and master clips.

3. Work with bins and 
clips to organize your 
source material for easy 
access during editing.

4. (Optional) Build a 
storyboard to begin 
previsualizing your 
final cut before editing.

Preparing to edit involves the following steps:

3. Sort and organize clips in the bins.

4. Previsualize with storyboards.

2. Record footage, creating
master clips and media files.

1. (Option) Import shot logs into the bin.
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Editing a Sequence

1. View your clips in 
advance and mark IN 
points and OUT points, 
or create subclips based 
on selected portions of 
your master clips.

2. Build your sequence 
using editing controls 
with the Timeline, 
Source pop-up 
monitors, and the 
Composer monitor.

3. Fine-tune your edits 
and effects by using 
functions of the various 
edit modes, such as 
Segment mode, Trim 
mode, and Effect mode.

4. Adjust and mix 
multiple audio tracks 
and prepare for final 
playback or output, 
using the Audio tool and 
Audio Mix tool.

5. Return to editing if 
further adjustments are 
required.

Editing a sequence involves the following steps:

Composer
monitor

Source
pop-up

Timeline

2. Edit with Timeline and monitors.

3. Fine-tune edits and effects.

4. Fine-tune audio pan, volume, and EQ.

5. Screen and 1. Screen, mark, and subcatalog footage.
continue editing
as necessary.

monitor
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Generating Output

Export material for 
audio sweetening or 
graphics enhancement 
in a third-party 
application, for 
incorporating into a 
multimedia project, or 
for publishing on the 
Internet.

Record the final 
sequence to tape as a 
digital cut.

Generate an EDL for 
online videotape 
editing.

Generating various forms of output based on your sequence involves 
selecting among several options:

Export material for additional processing,
for incorporating into a multimedia project,

Record a digital cut directly to tape.

Generate an EDL for online
videotape editing.

or for publishing on the Internet.

DV
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CHAPTER 3

Learning How to Use 
Avid Xpress DV

This chapter explains the different resources that can help you learn 
how to use your Avid Xpress DV system. This chapter contains the 
following sections:

• Using the Tutorial

• Using Help

• Using Online Documentation

• Tips and Other Resources
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Using the Tutorial

The self-paced tutorial chapters in this guide are designed as guided 
Avid editing sessions, using the basic features of the Avid system. In 
this tutorial, you’re going to edit a 1-minute sequence about Avid 
Technology, Inc. This sequence is typical of a short piece you might 
create for your own organization. You can publish the sequence on 
tape or CD-ROM, or stream it across the Internet.

The footage for the sequence is supplied on the Avid Xpress DV 
Tutorial CD-ROMs that came with your system. This footage is DV 
media that has already been recorded and is ready for you to use. 
Footage is supplied in either NTSC or PAL format, which is indicated 
on the CD-ROMs. 

This tutorial does not cover the process of recording video and audio 
from a camera or video deck. You can find instructions for recording in 
the Avid Xpress DV User’s Guide and Help.

Before you begin, make sure you have installed the tutorial media and 
project files (see “Installing the Avid Xpress DV Tutorial Files” on 
page 35).

Depending on your level of expertise in editing on Avid systems, you 
can choose to work through the tutorial in either of two ways.

• If you have no experience with Avid Xpress DV or other Avid 
systems, you should go through the entire tutorial. 

• If you have used other Avid systems, you might want to read 
certain chapters to understand the specific features of Avid Xpress 
DV and complete the tutorial tasks in that chapter. For most 
chapters, you can load a sequence that includes the work done up 
to that point.

You can create a short sequence in 5 minutes (see “Creating a Simple 
Sequence” on page 62). Completing the entire tutorial can take from 
3 to 4 hours. 
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Using Help

Avid Xpress DV has a comprehensive Help system that includes all 
information contained in the Avid Xpress DV User’s Guide, and most of 
the information contained in the Avid Xpress DV Effects Guide. In 
addition, you can get information on windows, dialog boxes, and 
screen objects by pressing the F1 key or clicking the right mouse 
button.

Opening and Closing the Help System
The Help system is also 
included on the 
Avid Xpress DV Online 
Publications CD-ROM.

To open the Help system, choose Avid Xpress DV Help from the Help 
menu. The Help Topics dialog box appears. Use the Contents, Index, 
and Find tabs to access the information you need.

These tabs work the same way as most Windows Help systems. For 
more information, see the section “Using Help” in the Help system or 
click the Question Mark button in the title bar of the Help Topics 
dialog box.

To close the Help system, click the Close button in each Help window. 
The Help system automatically closes when you close the last open 
Help window.

Getting Help for Windows and Dialog Boxes

The Help system provides you with context-sensitive Help for 
windows and dialog boxes, such as tools and settings. 

To get Help for windows and dialog boxes:

1. Make sure the Avid application is active.

2. Position the mouse pointer in the window or dialog box for which 
you want Help.

3. Press the F1 key on the keyboard.
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n If there is no information about a window or dialog box, the Help Topics 
dialog box appears.

Getting Help for Screen Objects

You can use What’s This? Help to find out about buttons and other 
screen objects.

To get Help for screen objects:

1. Using the right mouse button, click on the screen object (for 
example, a button).

A pop-up menu appears.

2. Choose What’s This? from the menu.

A pop-up window opens with an explanation of how you use the 
item. 

n If you press the F1 key when the mouse pointer is on a button or other screen 
object, you get Help for the window or dialog box, not for the button or other 
screen object.

Printing Help Topics

You can print a single Help topic or a group of topics listed in the 
Contents.

To print a Help topic:

1. Open or click the topic to make it active.

2. Click the Print button in the topic window.

3. Select the print options. 

4. Click OK.
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To print a Help topic from the Contents tab:

1. Select the topic you want to print.

2. Click the Print button at the bottom of the tab.

To print a book of related topics from the Contents tab:

1. Select the book you want to print.

2. Click the Print button.

If you select a book, all topics within that book, and all topics in other 
books contained in that book, will be printed. The system sends each 
topic as a separate print job to the printer; therefore, printing can take 
a long time. You can more easily print large sections of user 
information from the Avid Xpress DV Online Publications CD-ROM.

You can print a pop-up window by clicking the right mouse button 
and selecting Print.

Using Online Documentation

The Avid Xpress DV Online Publications CD-ROM includes:

• Avid Xpress DV User’s Guide

• Avid Xpress DV Effects Guide

• Avid Xpress DV Getting Started Guide (this book)

• Avid Xpress DV Help

The books are PDF files. You can view them with the 
Adobe Acrobat Reader, which you can install from the CD-ROM.
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These online books enable you to:

• Navigate by using bookmarks and hyperlinks.

• Speed up information retrieval by performing keyword searches.

• Annotate the books with your own notes.

• Zoom in on a page, enabling closer review of text and images.

• Print any or all pages.

• View the books with full-color graphics.

• View movies that illustrate Avid Xpress DV effects.

n Avid gives you permission to print up to three complete copies of each book.

Tips and Other Resources

The following are a few tips for taking full advantage of the 
Avid Xpress DV documentation and other resources:

• Complete the tutorial chapters in this guide before starting a 
project.

• Begin learning about basic procedures by using the default 
settings. As your confidence increases, explore additional 
procedures and settings.

• Instead of using the standard menus to find the command you 
need in a window, try using shortcut menus. Using the right 
mouse button, click on a window to open a shortcut menu that 
shows the most frequently used commands for that window.

• Keep the Avid Xpress DV Quick Reference available during editing 
sessions. 

• Read Avid’s newsletters, mailings, and other trade publications.
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• Make use of additional training resources provided by Avid 
whenever possible, such as classes and instructional videotapes. 
For more information, contact Avid at 800-867-2843.

• Check the following Avid Web site for listings of courses, 
schedules, and locations:

www.avid.com/services/training/training.html
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CHAPTER 4

Starting a Project and 
Creating a Simple Sequence

This chapter begins the tutorial section of this guide. In this chapter 
you’ll practice the following tasks:

• Starting Avid Xpress DV

• Using the Open Project Dialog Box

• Creating a Simple Sequence

• Closing the Project and Quitting the Application

Before starting this chapter, make sure you have installed the tutorial 
files (see “Installing the Avid Xpress DV Tutorial Files” on page 35).
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Starting Avid Xpress DV

You can create a 
shortcut on the desktop 
and start the 
application by double-
clicking the icon. See 
your Windows NT 
documentation.

You start the Avid Xpress DV application the same way you start most 
Windows applications. 

1. Click the Start button.

2. Point to Programs, point to Avid, and select Avid Xpress DV.

The first few times you start Avid Xpress DV, a window opens that 
contains the License Agreement.

3. To accept your Avid Xpress DV product license electronically:

a. Read the License Agreement, and then click the Accept button 
or the Decline button at the bottom of the screen.

The agreement appears the first several times you start 
Avid Xpress DV. After several starts, a new button appears at 
the bottom of the screen labeled Accept and Don’t Show 
Again.

b. If you don’t want to see the License Agreement again, click the 
Accept and Don’t Show Again button.

A dialog box appears.

c. Enter the name of your organization in the dialog box, and 
click OK.

After you accept the License Agreement, the Open Project dialog 
box appears. If you are the first user on the system, the Open 
Project dialog box appears as shown in the following illustration.
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For this tutorial, you will use the project called either Introducing 
Avid (NTSC) or Introducing Avid (PAL).

Using the Open Project Dialog Box 

To open a project, you select a user and a project from the Open Project 
dialog box. You also use this dialog box to create a new user or a new 
project.

Creating a User

For this tutorial, create a new user.

1. Click the New User button in the Open Project dialog box.

The New User dialog box appears.
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By default, the Windows NT login name appears.

2. Delete the default name, type your name, and click OK. 

The Open Project dialog box reappears with your name 
highlighted in the list of Avid Users.

Selecting and Opening a Project

For this tutorial, we’ve already created a project for you.

1. Select Introducing Avid (NTSC) or Introducing Avid (PAL) from 
the Avid Projects list.

2. Click OK.

The Project window opens. 
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Look at the title bar of the window. It contains the name of the project 
and the name of the user. In this example, the user is named Editor. 
Your project window will contain your user name.

Two other windows appear: the Composer window and the Timeline 
window. You’ll learn about these windows in Chapter 6.

Creating a Simple Sequence

Before continuing further in the tutorial, you can create a simple 
sequence right away. A sequence is a program made up of one or more 
clips (see “Sequences” on page 42). These steps will get you started 
quickly; you’ll find more thorough instructions and explanations later 
in the tutorial.

The sequence uses footage from the Introducing Avid project that you 
just opened. The following illustration shows the Project window.

Source Clips bin
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Follow these steps to create a sequence:

1. In the Project window, open the Source Clips bin by double-
clicking the bin icon.

The Source Clips Bin window opens and displays a list of clips.

2. From the list of clips, double-click the icon for the Editor at 
keyboard clip.

The Editor at keyboard clip opens in a window. This window is 
known as a Source pop-up monitor.

Editor at keyboard clip
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3. Click the Mark Clip button, which is located at the bottom of the 
Source pop-up monitor. 

IN and OUT points appear at the beginning and end of the clip, 
which indicate that the entire clip will be edited into the sequence.

Mark Clip button

IN point OUT point
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4. Click the image area of the Source pop-up monitor and drag it 
anywhere in the Timeline window.

n If you have more than one bin open, a dialog box appears and asks you to 
select a bin in which to store the sequence. Select Source Clips.

Congratulations! You’ve just created your first sequence. The clip 
appears in the Timeline and in the Composer monitor.

Notice the vertical blue line at the end of the Timeline.This line is 
called the position indicator. The position indicator is parked on the 

Position indicator
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last frame of the sequence, so this frame is the one displayed in the 
Composer monitor. 

5. Now add some music to the sequence. 

a. In the Source Clips bin, double-click the icon for the Music 
track clip.

The clip opens in a Source pop-up monitor. There is no image 
because the clip has only audio.

b. Click the image area and drag the clip to audio track A1 in the 
Timeline. Drag the clip so that the A1 track is outlined, as 
shown in the following illustration, and then release the 
mouse button.

If you make a mistake, 
choose Undo from the 
Edit menu to undo your 
last action.

6. In the Timeline, make sure the position indicator is at the 
beginning of the sequence. If not, drag the position indicator as far 
as you can to the left.

Drag the position indicator here.
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7. Click the Play button below the Composer monitor to review your 
sequence.

Press the Play button again to stop playing the sequence at any 
time.

Now look in the Source Clips bin. The sequence is saved in the bin 
with the name Untitled Sequence.01. Delete the sequence. You’ll 
create a new one in Chapter 6.

8. In the Source Clips bin, click the Untitled Sequence.01 icon and 
press the Delete key on the keyboard.

The Delete dialog box appears.

Play button
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9. Click OK.

You’ve deleted the sequence, but not the source footage.

10. Close the Source Clips bin by clicking the Close button in the 
upper right corner of the window.

Next Steps

You’ve finished this chapter of the tutorial. You can either:

• Close the project and application and continue the tutorial at a 
later time.

• Continue on to the next chapter.

Closing the Project and Quitting the Application

To close the project and 
quit the application 
immediately, choose 
Exit from the File menu 
or click the Close button 
in the Avid Xpress DV 
title bar.

If you want to close the project and quit the application:

1. Click the Project window to activate it, and then click the Close 
button.

The system saves and closes the project. The Open Project dialog 
box appears.

2. Click Quit.

A dialog box appears and asks if you want to quit the application.

3. Click Leave.

The application quits and you see the Windows NT desktop.

The next time you open the project, choose your user name and project 
name, and resume the tutorial with the next section.

Close button
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CHAPTER 5

Playing and Marking Clips

In Chapter 4 you learned how to start a project. In this chapter you’ll 
practice the following tasks:

• Exploring the Project Window

• Opening a Bin

• Viewing Clips

• Playing Clips in a Source Pop-up Monitor

• Marking IN and OUT Points

• Playing a Sequence in a Source Pop-up Monitor

• Using Timecode to Find a Frame

• Creating Subclips

• Clearing IN Points and OUT Points

• Saving Your Work

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, choose your user name and 
the Introducing Avid project, and then click OK.

If you have not worked on the previous chapters — Start the 
application, create a new user, choose the Introducing Avid project, 
and then click OK.
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Exploring the Project Window
Click in the Project 
window and press the 
F1 key to open Help for 
the Project window.

The Project window must remain open whenever you are working in 
Avid Xpress DV. Depending on the button you click, the Project 
window displays a list of bins, a list of settings, or information about 
your system.

n If the Project window becomes hidden by other windows, bring it forward by 
choosing Project from the Tools menu.

The Bins Display

The Bins display lists the bins, or storage areas, created to hold your 
clips and sequences (you’ll learn more about bins later in this chapter). 
For the Introducing Avid project, we’ve supplied you with three bins:

• QuickTime Movies

• Sequences

• Source Clips
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The Settings Display

Click the Settings button at the top of the Project window. A list of 
settings appears. This list is called the Settings scroll list. Settings are 
groups of options you can select, depending on your needs and 
preferences.

The right column 
displays the type of 
setting. User settings 
are associated with the 
current user, and Project 
settings are associated 
with the project. For 
more information, see 
the Avid Xpress DV 
User’s Guide or press F1 
for Help.

Especially important for Avid Xpress DV are the Video Display 
settings. Check the settings now.

1. Scroll down the list of settings and double-click Video Display.

The Video Display Settings dialog box appears.
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For information on 
connecting a camera 
and Client monitor, see 
Appendix A.

The top part of the dialog box gives you a choice for how to 
display video on your desktop. 

2. If you have a Client monitor (a separate monitor that displays 
NTSC or PAL video) and camera attached to your system, select 
the following options:

• DV camera supports digital video input 

• External video (client monitor enabled)

• External Video Source (S-Video or Composite, depending on 
the connection between your camera and the capture board.
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To learn more about these options, see the Avid Xpress DV User’s 
Guide or press the F1 key for Help. All Settings dialog boxes have 
context-sensitive Help.

3. Click OK to close the Video Display Settings dialog box.

The Info Display

Click the Info button at the top of the Project window. You see the 
format of the project (NTSC or PAL). You can get information about 
your system by clicking the Fast Menu button in the lower left corner 
of the screen, and then choosing Profile, Memory, or Hardware from 
the pop-up menu.

Click the Bins button to return to the Bins display.

Opening a Bin

The term bin comes from film editing and refers to a container for 
holding film clips (see “Bins” on page 43).

Let’s open a bin now. In the list of bins in the Project window, 
double-click the Source Clips icon. The Source Clips bin opens.

Most of the clips you’ll use in your sequence are displayed in this bin.

Fast Menu button



74

Viewing Clips

You can view the information in a bin in two different ways:

• Text view displays columns of information about your clips.

• Frame view displays each clip as a single representative image.

Using Text View

Let’s look at Text view.

1. Click the Text View button (T) in the lower left corner of the bin.

If the button is highlighted, you are already in Text view.

The bin displays columns of information about each clip. For 
explanations of these columns, see the Avid Xpress DV User’s Guide 
or press the F1 key for Help.

Text View Frame View 

Name heading

button button
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You can rearrange the clips in the bin by sorting on a particular 
column. Let’s sort alphabetically by clip name.

2. Click the Name heading in the bin.

3. Choose Sort from the Bin menu.

The clip names are rearranged in alphabetical order.

Using Frame View

Now let’s look at Frame view.

1. Click the Frame View button (F) in the lower left corner to see a 
picture-frame representation of each clip in the bin.

n The order of clips is different from the order in Text view. You can rearrange 
clips in either view independently of the other.

You can change the size of the frames if you want.

2. Choose Reduce Frame or Enlarge Frame from the Edit menu.
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To change frame size at the keyboard, you can also press Ctrl+K 
(Reduce Frame) and Ctrl+L (Enlarge Frame).

3. Choose Fill Window from the Bin menu.

The clips are arranged in neat rows and columns in the bin.

4. If some clips are now off the screen, click and drag the window 
corner in the lower right corner of the Source Clips bin. 

Switching Between Views

It’s easy to switch between views: click the T button for Text view and 
the F button for Frame view. For this tutorial, you can use whichever 
view you prefer, except when performing a storyboard edit (see 
“Storyboard Editing the Clips” on page 117).

Playing Clips in a Source Pop-up Monitor

A Source pop-up monitor is a window in which you play the clips for 
your project. You can play clips in three different ways:

• Using the keyboard

• Using the buttons on the screen, below the Source pop-up monitor

• Using the blue position indicator (the “blue bar”)

In this section you’ll try different ways to play clips. As you edit, use 
the ones you prefer.

Using the Keyboard to Play Clips
Your system is shipped 
with a set of labels that 
you can place on the 
keys of your keyboard.

The keyboard for your Avid system includes many special control 
keys, as shown in the following illustration.
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This illustration shows the U.S. English keyboard. For layouts of other 
keyboards, choose Keyboard from the Settings scroll list.

In this section you’ll experiment with different ways to play clips. 

1. In the Source Clips bin, open the clip named Editor at keyboard 
by double-clicking the icon (in Text view) or anywhere in the 
image (in Frame view).

The Editor at keyboard clip appears in a Source pop-up monitor.

Stop key

Play/Step/Shuttle keysStep keys Home keyEnd key
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2. Press the Home key (between the main keyboard and the numeric 
keypad) to move the position indicator to the start of the clip.

3. Press the End key, just below the Home key, to go to the end of the 
clip. The blue position indicator moves to match your directions.

4. Press the Home key again to go to the start of the clip.

5. Press the L key (Play) on the keyboard to play the clip forward at 
normal speed.

There is no audio for the Editor at keyboard clip.

n The small size of the Source pop-up monitor might cause the footage to look 
jerky. The footage will look smoother in the Composer monitor and the Client 
monitor.

6. Press the space bar on the keyboard to stop playback at any point.

7. Press the L key again to play the clip forward at normal speed. 
Press the key repeatedly to play the clip forward at 60, 90, 150, and 
240 frames per second (NTSC) or 50, 75, 125, and 200 frames per 
second (PAL). 

8. Press the J key (Reverse Play) on the keyboard to play the clip 
backward at normal speed. Press the key repeatedly to play the 
clip backward at 60, 90, 150, and 240 frames per second (NTSC) or 
50, 75, 125, and 200 frames per second (PAL). 

9. Press the K key (Pause) on the keyboard to pause playback.

10. To move forward or backward at slow speed, press and hold the K 
key while you press and hold the L or J keys.

11. Use the 1, 2, 3, and 4 keys to step through the footage forward or 
backward in 1-frame or 10-frame increments.
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Using Buttons and the Position Indicator to Play Clips

Two additional ways to play clips are:

• Clicking buttons that appear under a Source pop-up monitor

• Dragging the blue position indicator through the position bar to 
scroll through a clip

Now play through the Editor at keyboard clip by using buttons and 
the position indicator.

1. Click the Play button under the Source pop-up monitor.

2. Click the Play button again to stop playback at any point.

To step forward or 
backward 10 frames, 
hold the Alt key while 
you click the Step 
Forward or Step 
Backward 
button.

3. Step through the footage forward or backward in 1-frame 
increments by using the Step Forward and Step Backward buttons 
under the Source pop-up monitor.

4. Locate the blue position indicator in the position bar in the Source 
pop-up monitor.

Step 10
Frames Backward

Step 10
Frames Forward

Step 1
Frame Backward

Step 1
Frame Forward

Play 
 

Position
bar

Step Step

Position indicator

Backward Forward
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To step several frames 
forward, click just to the 
right of the position 
indicator.

5. Click to the left of the position indicator to step several frames 
back in the clip.

6. Step through the clip by clicking different spots in the position bar.

7. Drag the position indicator to the left, then to the right, to scroll 
through the clip.

Marking IN and OUT Points

Before you start to create your sequence, you need to mark the 
segments of the clips you want to use. In this section you’ll mark 
IN and OUT points for some clips you’ll use later to build your 
sequence. You’ll also learn how to use timecode and frame offset to 
locate IN and OUT points.

n The instructions in this section use the keyboard to mark IN and OUT points, 
but you can also click the equivalent buttons below the Source pop-up 
monitor.

Marking the First Clip

Let’s mark IN and OUT points for the Editor at keyboard clip.

1. Go to the head (start) of the clip by pressing the Home key. Then 
use the Step Forward and Step Backward (3 and 4) keys to locate 
the frame where the letter A begins to appear on the monitor 
screen.
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Your clip might already have IN and OUT points. Your new edit 
points will overwrite the old edit points.

2. Mark an IN point by pressing the Mark IN (I) key.

A white sawtooth pattern appears on the left edge of the frame.

3. Drag the position indicator toward the end of the clip, where the 
explosion appears on two monitors, and before it fades away.
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4. Mark an OUT point by pressing the Mark OUT (O) key.

A white sawtooth pattern appears on the right edge of the frame.

The system saves your IN and OUT points until you change them.

5. Close the Editor at keyboard clip by clicking the Close button.

The system automatically saves your IN and OUT points.
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Marking Another Clip

Now mark the IN and OUT points for the Eyeball clip. This time, 
instead of using the Step keys, use the J-K-L keys to play the clip.

1. Open the Eyeball clip.

n In this tutorial, “open a clip” means to double-click its icon in a bin, so that it 
opens in a Source pop-up monitor.

2. Locate the frame where the letter A of the word Avid appears in 
the pupil of the eyeball (after the second blink). Press and hold the 
K key and press the L key to go forward or the J key to go 
backward in slow motion.

Use the 3 and 4 keys to locate the precise frame.

3. Mark an IN point by pressing the I key.

4. Step forward a few frames after the D appears.
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5. Mark an OUT point by pressing the O key.

6. Close the Eyeball clip.

Playing a Sequence in a Source Pop-up Monitor

So far you have played clips in Source pop-up monitors. You can also 
play a sequence (a program made up of one or more clips) in a Source 
pop-up monitor. 

You might be curious to see what your final sequence will look like. 
We have supplied a finished sequence for you. To play it:

1. Click the Project window to display and activate it.

The Project window might be hidden behind the Source Clips bin. 
You can choose Project from the Tools menu to bring the window 
forward.

2. Open the Sequences bin.

3. Open the Introducing Avid sequence.
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4. Press the Home key to go to the beginning of the sequence. Play 
the sequence in the Source pop-up monitor, using the keyboard or 
buttons, or a combination of both.

5. Close the Introducing Avid sequence.

6. Close the Sequences bin.

Using Timecode to Find a Frame

Your Avid Xpress DV system uses timecode to identify each frame of a 
clip. 

About Timecode

Timecode is an electronic indexing method that denotes hours, 
minutes, seconds, and frames that have elapsed on a videotape. For 
example, a timecode of 01:03:30:10 denotes a frame that is marked at 
1 hour, 3 minutes, 30 seconds, and 10 frames.

NTSC video (the video format used mainly in the United States) uses 
one of two formats: drop-frame timecode and non-drop-frame timecode.

Drop-frame timecode is designed to match the NTSC scan rate of 29.97 
frames per second (fps). Two frames of timecode are dropped every 
minute except for the tenth minute. No video frames are actually 
dropped. Drop-frame timecode is indicated by semicolons between 
the digits; for example, 01;00;00;00. DV cameras that use the NTSC 
format use drop-frame timecode.

Non-drop-frame timecode tracks NTSC video at a rate of 30 fps and is 
indicated by colons between the digits; for example, 01:00:00:00. Non-
drop-frame timecode can be easier to work with, but does not provide 
accurate timing for NTSC broadcast.
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PAL video (the video format used in many countries other than the 
United States) uses a scan rate of 25 fps. Timecode is indicated by 
colons. There is no need for drop-frame timecode in PAL video.

You can change the starting timecode of a sequence or, for NTSC 
projects, the type of timecode. See “Changing the Timecode of the 
Sequence” on page 180 and the Avid Xpress DV User’s Guide.

Using Timecode to Mark IN and OUT Points

You can mark IN and OUT points by using timecode as your reference 
point. If you know the timecode for the frame you want to mark, you 
can go to that frame instantly by typing it on the numeric keypad.

In this section, you’ll use timecode to reach a specific location. First, 
you need to display the appropriate timecode information in the 
Tracking Information display.

1. Open the Hand and keyboard clip.

2. Place the pointer in the gray title bar area over the Tracking 
Information display, until the pointer changes to a downward 
arrow.

3. When the pointer changes to a downward arrow, click to display 
the Tracking Information pop-up menu, and then choose TC, V1 
(timecode for track Video 1) from the menu. A check mark means 
it is selected.

Tracking Information display
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For information about 
the other choices in the 
Tracking Information 
menu, see the 
Avid Xpress DV User’s 
Guide or place the 
pointer over the 
Tracking Information 
display, click the right 
mouse button, and 
choose What’s This?

The timecode refers to the frame displayed in the Source pop-up 
monitor.

n After you change the display for one Source pop-up monitor, all subsequent 
Source pop-up monitors you open use the same display.

4. Use the Play and Step buttons to locate the frame with the 
timecode 01:08:14:18 (NTSC) or 00:01:42:23 (PAL). Look for the 
number in the Tracking Information display.

5. Click the Mark IN button.

6. Let’s use 2 seconds of this clip. You can determine the OUT point 
by adding 2 seconds to the timecode of the IN point, as shown in 
the following examples:

01:08:14:18 (NTSC)
+ 2:00
01:08:16:18

or

00:01:42:23 (PAL)
+ 2:00
00:01:44:23

Because Avid Xpress DV counts the frame it is parked on, you will 
actually mark one frame more than 2 seconds.

7. Type 01:08:16:18 (NTSC) or 00:01:44:23 (PAL) on the 
numeric keypad. 

Timecode shows the following:
Hours
Minutes
Seconds
Frames
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n You don’t need to type zeros that start the timecode. In addition, the system 
inserts the colons for you. So you only need to type 1081618 (NTSC) or 
14423 (PAL). This guide provides the complete timecode, but you can use 
these shortcuts to type the numbers.

As you start typing, a window opens in the middle of the Source 
pop-up monitor, showing the numbers you type.

8. Press the Enter key on the numeric keypad. The position indicator 
locates the specified frame. 

The Timecode window displays the current number. 

n To locate frames by using timecode and the numeric keypad, you must show 
timecode in the Tracking Information display. For example, the display must 
show track V1 to go to a specific frame on the V1 track.

9. Click the Mark OUT button.

10. Close the Hand and keyboard clip.

Timecode 
entered

Tracking Information
display
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Using Frame Offset
Whenever you use the 
numeric keypad, you 
must press the Enter 
key on the numeric 
keypad after typing the 
number. 

You can also use the numeric keypad to move the position indicator 
forward or backward a specified number of frames. This technique is 
called frame offset. Let’s mark an IN point for the Editor at keyboard 3 
clip and then use frame offset to locate the OUT point.

1. Open the Editor at keyboard 3 clip.

2. Use the numeric keypad to type 01:23:24:02 (NTSC) or 
00:03:07:15 (PAL), and then press the Enter key.

3. Click the Mark IN button.

4. Advance 29 frames (NTSC) or 24 frames (PAL) by typing +29 or 
+24 on the numeric keypad and pressing the Enter key. 

Advancing 29 or 24 frames is the equivalent of advancing 
1 second, because Avid Xpress DV counts the frame it is 
parked on.

5. Advance 2 more seconds by typing +129 (NTSC) or +124 (PAL) 
and pressing Enter. The system inserts the colons for you. 

If you want to move 
back a certain number 
of frames, type a minus 
sign (–) instead of a 
plus sign (+) in front of 
the number.

6. Mark that frame as the OUT point by clicking the Mark OUT 
button.

7. Close the Editor at keyboard 3 clip.

Creating Subclips

Now you’ll copy portions of one clip into shorter clips, called subclips 
(see “Subclips” on page 41). Subclipping is a great way to organize 
your footage into manageable units.

1. Open the Lab clip.

2. Go to the start of the clip.



90

3. Review the clip by clicking the Play button or by dragging the 
blue position indicator. There are two parts of the clip that you’ll 
copy into separate subclips.

4. Use the numeric keypad to type 01:24:53:19 (NTSC) or 
00:04:10:22 (PAL), and then press the Enter key.

5. Mark an IN point.

6. Type 01:24:57:16 (NTSC) or 00:04:14:20 (PAL).

7. Mark an OUT point.

8. Press and hold the Alt key, click the image area of the clip, and 
drag it from the Source pop-up monitor to the Source Clips bin.

As you begin dragging, the pointer changes to a hand attached to 
a small box.

The subclip has the 
name of the original 
clip, followed by Sub.n, 
where n is the number 
of times the master clip 
has been cataloged to 
that bin. 

A new item called Lab.Sub.01 appears in the Source Clips bin. 
The name is highlighted.

9. Delete the name Lab.Sub.01 and rename the subclip Lab 1A.

Clearing IN Points and OUT Points

Now you’ll clear previous IN and OUT points, mark new IN and OUT 
points, and create a new subclip.

1. Bring the Lab clip forward by choosing Lab from the Windows 
menu. 

2. Press the Clear IN key (D) and Clear OUT key (F).

You can also click the corresponding buttons beneath the monitor.

3. Mark an IN point at 01:25:00:11 (NTSC) or 00:04:17:03 (PAL).

4. Mark an OUT point at 01:25:07:16 (NTSC) or 00:04:25:12 (PAL).
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5. Press and hold the Alt key, click the image area of the clip, and 
drag it from the Source pop-up monitor to the Source Clips bin.

The clip name is highlighted in the Source Clips bin.

6. Delete the name Lab.Sub.02 and rename the subclip Lab 1B.

7. Close the Lab clip.

8. Close the Source Clips bin.

Saving Your Work

By default, Avid Xpress 
DV includes an Auto-
save function set at 15 
minutes. You can view 
or change this setting in 
the Bin settings box, 
which you access from 
the Settings scroll list in 
the Project 
window.

You’ve done a lot of work marking clips. Saving your bins and other 
project information would be a good idea.

1. Click the Project window to activate it.

2. Choose Save All from the File menu.

Next Steps

You’ve prepared some clips that you’ll use in your sequence. In the 
next chapter you’ll start to edit your sequence. You can continue to the 
next chapter, or quit this session (see “Closing the Project and 
Quitting the Application” on page 68). The next time you open the 
project, the windows will be in the same position.
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CHAPTER 6

Creating a Sequence

In this chapter, you begin editing the Introducing Avid sequence by 
completing the following tasks:

• Working in the Avid Xpress DV Window

• Making the First Edit

• Opening a Sequence

• Opening and Using the Tool Palette

• Splicing in an Audio Clip

• Exploring the Timeline

• Splicing in a Video Clip

• Splicing a Clip into the Middle of a Sequence

• Undoing an Edit

• Splicing in a Music Track

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, choose your user name and 
the Introducing Avid project, and then click OK.

If you have not worked on the previous chapters — Start the 
application, create a new user, choose the Introducing Avid project, 
and then click OK.
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Working in the Avid Xpress DV Window

You’ve been working in a single large window, labeled Avid Xpress 
DV. Like other Windows NT windows, you can minimize it, maximize 
it, and close it by using the buttons on the right side of the title bar.

Within the Avid Xpress DV window, you can manage the Timeline, 
bins, and Source pop-up monitors in the same way. The difference is 
that, when you reduce or resize these windows, they remain within 
the Avid Xpress DV window, rather than appearing on the Windows 
desktop.

n You cannot minimize the Composer window.

Minimizing Avid Xpress DV Windows

To get more space 
below the Timeline, 
right-click the 
Windows toolbar, 
choose Properties from 
the pop-up menu, and 
deselect the Always on 
Top check box.

Try minimizing some windows now. 

1. Open the Source Clips bin.

2. Click the Minimize button on the Source Clips window and the 
Timeline. The windows shrink to small title bars at the bottom of 
the Avid Xpress DV window.

3. Close the Source Clips bin by clicking the Close button.

4. Return the Timeline to full size by clicking the Restore button.

Managing your Avid Xpress DV windows will become more 
important as your projects become larger. 

Minimize
Maximize

Close

Restore button
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Default Locations for the Avid Xpress DV Windows

The Composer, Timeline, and Project windows have default sizes and 
locations to maximize the available space on your desktop, as shown 
in “Dragging a Video Clip and Creating a Sequence” on page 95.

If you want to return these windows to the default locations, click the 
window and choose Home from the Windows menu.

Making the First Edit

In this section, you’ll make your first edit and create a sequence by 
completing the following tasks:

• Playing a Video Clip

• Dragging a Video Clip and Creating a Sequence

• Moving and Renaming the Sequence

Playing a Video Clip

Let’s start by playing the clip that will begin the sequence. 

1. In the Project window, open the QuickTime Movies bin.

2. Double-click the Opening logo.mov clip to display it in a Source 
pop-up monitor. Play the clip through.

Notice the .mov file name extension. This indicates that the clip is 
a QuickTime movie that was created by using a special effects 
program. You can import a QuickTime movie into Avid Xpress 
DV, which changes the QuickTime movie to a DV clip. We’ve 
already imported the movie for you.
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Dragging a Video Clip and Creating a Sequence

Now edit the clip to create a sequence.

1. Make sure the Timeline is open and visible. If it is not, choose 
Timeline from the Tools menu.

2. Click the Source pop-up monitor that contains the Opening 
logo.mov clip. If the monitor is not visible, open it from the 
QuickTime Movies bin.

3. Click the Mark Clip button on the Source pop-up monitor. 

The Mark Clip button marks IN and OUT points at the beginning 
and end of the clip, so that the entire clip is edited into the 
sequence.

4. Click the image area of the clip and drag it to the Timeline 
window.

You’ve just created a sequence. 

n If you have more than one bin open, a dialog box appears and asks you to 
select a bin in which to store the sequence. Select QuickTime Movies.

Look at the Timeline. You should see the Opening logo.mov clip 
in track V1. The first frame is the IN point you marked in the clip; 
the last frame is the OUT point you marked. The position indicator 
rests on the last frame of the clip, as shown in the following 
illustration.
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The sequence also appears in the Composer monitor. The image is 
black because the last frame of the clip is black. Notice the right 
angle and vertical line in the lower right corner of the Composer 
monitor. The right angle indicates the end of a cut and the vertical 
line indicates the end of the sequence.

Position indicator

Right angle and
vertical line
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When you want to 
bring an open bin or 
monitor to the 
foreground, you can 
click anywhere in it or 
choose its name from 
the Windows menu.

5. Click anywhere in the Composer monitor to activate it.

6. Press the Home key to move to the head of the sequence.

7. Click the Play button at the bottom of the Composer monitor to 
play the clip in the sequence.

8. Close the Opening logo.mov clip.

Moving and Renaming the Sequence

You can create a new 
sequence by choosing 
New Sequence from the 
Clip menu. 

Because the QuickTime Movies bin was the only bin open, the 
sequence appears in that bin. By default, Avid Xpress DV names the 
sequence Untitled Sequence.01. Now let’s move the sequence to the 
Sequences bin and change its name.

1. In the Project window, click the Bins button.

2. Open the Sequences bin.

3. In the QuickTime Movies bin, click the icon in front of the name 
Untitled Sequence.01 and drag it to the Sequences bin.

4. Click the name Untitled Sequence.01 to select it.

The name is highlighted.
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5. Type Rough Cut and press the Enter key.

This is the sequence you’ll be working with for this tutorial. The 
sequences Rough Cut 1, Rough Cut 2, and Rough Cut 3 are 
supplied for those who prefer not to build their own sequence (see 
the notes at the beginning of each chapter).

6. Close the QuickTime Movies bin.

7. Close the Sequences bin.

By closing the Sequences bin, you also close the sequence.

Opening a Sequence

In Chapter 5 you opened a sequence in a Source pop-up monitor (see 
“Playing a Sequence in a Source Pop-up Monitor” on page 84). To 
open a sequence for editing, you need to drag it into the Composer 
monitor or the Timeline.

1. Open the Sequences bin.

2. Drag your Rough Cut sequence to the Composer monitor.

The sequence appears in the Composer monitor and the Timeline.

You need to keep the Sequences bin open to continue working on 
your sequence. You can minimize the bin to save workspace on your 
desktop.

Opening and Using the Tool Palette

Before you continue with your editing, familiarize yourself with the 
Tool palette. So far you have been using buttons that appear below the 
Source pop-up monitor or keyboard equivalents. The Tool palette 
provides you with additional buttons for navigating and editing. 
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Opening and Tearing Off the Tool Palette
You can also open the 
Tool palette from the 
Fast Menu button on a 
Source pop-up monitor.

Open the Tool palette by clicking the Fast Menu button under the 
Composer monitor.

To use a button on the Tool palette, just click it. You can also “tear off” 
the palette and drag it to a different location.

1. If the Tool palette is not open, click the Fast Menu button.

2. Drag the pointer over the buttons and then outside the border of 
the Tool palette. You should see a dotted line outline. Drag the 
outline to another location. You see the complete Tool palette, with 
a title bar and Close button.

You can drag the Tool palette to a different location; just click and hold 
anywhere on the Tool palette and drag it wherever you want. You can 
also resize it to a square or a single row, to suit the way you want to 
work.

All buttons in 
Avid Xpress DV have 
ToolTips.

To view the name of each button, slowly drag the pointer across each 
button. You should see a small yellow window pop up with the name 
of each tool. You’ve probably seen these pop-ups in other Windows 
applications; they’re called ToolTips. 

Fast Menu button
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Displaying Button Names

You can display a shortened name on the button itself by selecting an 
option in the Interface Settings dialog box.

1. In the Project window, click the Settings button.

2. From the Settings scroll list, double-click Interface.

The User Interface Settings dialog box appears.

3. Select the option Show Labels in Tool palette.

4. Click OK.

You see names on the first row of buttons. 

5. Click the border of the Tool palette and drag it until you see the 
second row of buttons. 

You can keep these names or remove them by deselecting the 
Show Labels in Tool palette option in the User Interface Settings 
dialog box. For this tutorial, you might want to keep the labels 
visible.

6. Close the Tool palette by clicking the Close button.

Splicing in an Audio Clip

The next clip, Narration, provides the voice of an off-camera narrator, 
or voice-over. This clip includes only audio. 
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To edit this clip into the sequence, you’ll use the Splice-in button on 
the Tool palette. Splicing is a film term that refers to joining together 
two pieces of film.

n Now that you’ve had some experience marking and playing clips, the 
instructions will be less specific about which keys to press or buttons to click.

1. In the Project window click the Bins button.

2. Open the Source Clips bin.

3. Open the Narration clip.

4. Go to the head of the clip.

5. Play some or all of the clip.

The clip appears black because it’s audio only.

Using Digital Audio Scrub to Locate a Specific Frame of Audio

The term audio scrub originated in the film industry. It describes the 
process of “scrubbing” a magnetic audiotape across the playback 
heads to monitor a portion of sound. This process helps isolate 
portions of audio to accurately mark edit points.

Your Avid Xpress DV system uses a digital version of audio scrub to 
locate a specific frame of audio. Use it now to locate the first frame of 
audio in the clip.

1. Go to the head (start) of the Narration clip.

2. Press the Caps Lock key to activate digital audio scrub.

3. Play the clip again. Stop at the approximate place where the voice 
begins.

4. Use the Step keys to locate the first frame of the voice.

When you use the Step keys, a frame of audio sounds scratchy or 
buzzlike. You might need to increase the volume of your speakers 
to hear the first frame of audio.
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5. After you have located the first frame of audio, step back one 
frame and mark an IN point.

6. Go to the tail (end) of the clip.

7. Step back to find the last frame of audio, and then step forward 
one frame. 

8. Mark that frame as the OUT point.

Press the Caps Lock key again to deactivate digital audio scrub.

Playing IN to OUT

Now you can play only the marked portion of the clip to make sure 
you have marked IN and OUT points correctly.

Press the Play IN to OUT (6) key on the keyboard.

The clip plays from the IN point to the OUT point. If the audio sounds 
cut off, redo your IN and OUT points.

Splicing in the Clip

Now you’re ready to make the edit.

1. In the Timeline, make sure the position indicator is at the end of 
the Opening logo.mov clip.

2. Click the Fast Menu button on the Composer monitor to open the 
Tool palette.

3. Click the Splice-in button (the button with the yellow arrow) on 
the Tool palette.

The second clip is now edited into the sequence. Your Timeline 
should look like the one in the following illustration.
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4. Close the Narration clip.

Reviewing Your Edits

Review what you’ve done so far. 

1. Click the Composer monitor and go to the head of the sequence.

2. Play the sequence.

You should see the opening logo without sound, followed by the 
narration without video. You’ll be adding more clips later.

n If you try to play a sequence, and the outline of the Composer monitor flashes, 
another window is covering the Composer monitor. Click the Composer 
monitor to bring it forward or move the window that is covering it.

Exploring the Timeline

You can get context-
sensitive Help by 
pressing F1 or clicking 
the right mouse button 
and choosing What’s 
This?

Before you edit in the next clip, take a few minutes to explore the 
Timeline window. The Timeline is the graphical representation of the 
clips, effects, and other elements that make up your sequence.
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Displaying More or Less Detail in the Timeline

The scale box on the scale bar, below the Timeline on the left side of the 
window, expands and contracts the area centered around the blue 
position bar. The scale box allows you to zoom in to focus on a specific 
area of your sequence or to zoom out to see the whole sequence. 
Scaling the Timeline is especially useful when you have a lengthy 
sequence with many edits.

The Timeline always expands or contracts proportionally on both 
sides of the position indicator.

1. In the Timeline, click the transition point between the first two 
clips. A transition point or transition is where one clip ends and 
another clip begins.

2. Click the scale box and drag it to the right.

As the Timeline expands, a second “shadow” position indicator 
appears next to the blue position indicator showing the end of a 
single frame, and the two continue to move apart as you expand 
the Timeline.

Scale box

Scale bar

Position indicator Shadow position indicator
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The position indicator and its shadow mark the beginning and 
end of each frame. 

3. Click the scale box and drag it to the left to contract the expanded 
Timeline. You see less detail but more of the sequence.

Navigating in the Timeline

Two ways to navigate in the Timeline are by using the position 
indicator and the scroll bar.

Using the Position Indicator

You have already used the position indicator — the vertical blue line 
that marks your place in the sequence. You can drag it through your 
sequence to play the sequence, or you can click on a particular 
location, and the position indicator will jump there. Try it now.

The position indicator also determines how some of your commands 
are interpreted. For example, when you perform an edit, the system 
uses the location of the position indicator as the IN point, unless you 
have marked a different IN point.

When you move the position indicator in the Timeline, the smaller 
position indicator within the Composer monitor’s position bar also 
moves. Drag the position indicator again. This time watch the position 
bar of the Composer monitor.

Using the Scroll Bar

The scroll bar functions like any standard scroll bar. 

Scroll bar

Scroll box
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If your Timeline is contracted and fits the window, you won’t be able 
to scroll, and the controls in the scroll bar will be dimmed. If your 
Timeline is expanded, you’ll need to use it.

Use the Scale box to expand the Timeline, scroll through it, and then 
contract the Timeline.

Using the Track Selector Panel

The Track Selector panel, to the left of the Timeline, provides controls for 
working with multiple tracks. With this one panel, you can select, 
delete, monitor, enlarge, reduce, lock, patch, and move any video or 
audio track.

The following illustration shows a sample Track Selector panel. The 
panel might look different, depending on the source material or the 
work under way in the sequence.

The source side (left side) of the panel displays only those tracks 
available for the clip currently loaded and displayed in the Source 
pop-up monitor. In this example, the clip has video on track V1 and 
audio on track A1.

Source Track buttons

Sync Lock and Lock buttons

Record Track buttons

Audio Track Monitor buttons

Timecode button

Video Track Monitor buttons

Film Track button

Video Track Monitor button

Audio Track Monitor button
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The record side (right side) of the panel displays, by default, two 
tracks of video and four tracks of audio. You can add two additional 
video tracks and four additional audio tracks.

Selecting Tracks

There are also keyboard 
equivalents for 
selecting tracks. Check 
the Keyboard settings 
in the Project window 
Settings scroll list.

When you edit a clip into a sequence, you must make sure that you 
have selected the correct tracks to accomplish the edit you want. You 
select tracks by clicking the track buttons in the Track Selector panel. 
Selected tracks are colored (purple, by default), and deselected tracks 
are gray (dimmed).

For example, if you want to edit only the audio from a clip, select only 
track A1 on both the source and record sides and deselect the other 
tracks. If you want to edit only the video, select only track V1 on both 
sides.

Monitoring Tracks

By default, you monitor (view and hear) all tracks in your sequence. 
For this tutorial, you shouldn’t need to change the monitoring. 
However, you can change the monitoring by clicking a Track Monitor 
button on either the source side or record side of the Track Selector 
panel. 

The Video Track Monitor buttons determine whether you see video 
during playback. A Monitor icon indicates the top track that is 
monitored for playback and output. When there are multiple video 
tracks, all tracks below the monitored track are also monitored.

Video Track
Monitor icons
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The Audio Track Monitor buttons determine whether you hear audio 
during playback. A Speaker icon (either solid or green) indicates that 
the tracks are monitored for playback and output. However, only the 
track with the green icon is monitored for audio scrubbing.

n Be sure to activate the topmost video track and all audio tracks to view, 
render, or record all the tracks together. Unmonitored tracks are not included 
in playback.

Splicing in a Video Clip

You’ve already marked IN and OUT points for the Editor at keyboard 
clip. Now let’s add it to the sequence. Start by reviewing the clip.

1. In the Source Clips bin, open the Editor at keyboard clip.

Look for IN and OUT points. If there are no points, see “Marking 
the First Clip” on page 80.

2. Play the marked portion of the clip by pressing the Play IN to OUT 
(6) key. 

Adding Additional Frames

Now extend the clip by adding a few more frames.

1. Snap the position indicator to the OUT point by clicking the Go to 
OUT button on the Source pop-up Tool palette.

Audio Track
Speaker icons
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Whenever you use the 
numeric keypad, you 
must press the Enter 
key on the numeric 
keypad after typing the 
number.

2. Type +6 on the numeric keypad and press the Enter key to add 6 
frames to the clip.

3. Mark that frame as the OUT point.

The OUT point automatically moves to the new position.

n You can press and hold the Alt key and click the Mark OUT button, or press 
the O key, to go to the OUT point.

Splicing in the Clip
Now make the edit.

1. Select the tracks you want to edit:

a. On the source side of the Track Selector panel, make sure track 
V1 is selected. The button should be highlighted in purple, not 
dimmed (gray). If the button is gray, click it.

b. On the record side of the Track Selector panel, select record 
track V1 and deselect all other video and audio tracks. Keep 
the timecode track TC1 selected. 

2. In the Timeline, move the position indicator to the first frame of 
black after the Opening logo.mov clip. Look for the small white 
right angle in the lower left corner of the Composer monitor. 

3. Click the Source pop-up monitor for the Editor at keyboard clip.

4. Click the Splice-in button on the Tool palette or press the Splice-in 
(V) key on the keyboard to splice the clip into the Timeline as the 
third clip.

The Timeline should look like the one in the following illustration.
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5. Play some or all of the sequence to review it.

Splicing a Clip into the Middle of a Sequence

With nonlinear editing, you can splice a clip anywhere in your 
sequence. Let’s try inserting a clip between the Opening Logo.mov 
and Editor at keyboard clips.

1. Open the Eyeball clip.

You’ve already marked IN and OUT points for this clip. If an IN or 
OUT point is missing, see “Marking Another Clip” on page 83. 

2. Select the tracks you want to edit:

a. On the source side of the Track Selector panel, make sure track 
V1 is selected. 

b. On the record side of the Track Selector panel, make sure track 
V1 is selected and all other video and audio tracks are 
deselected. 
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Moving to the Head of a Clip

You want to insert the edit between the Opening logo.mov and Editor 
at keyboard clips. To move to the first frame of the Editor at keyboard 
clip:

You can also use this 
technique for snapping 
to the last frame of a 
clip. Click between the 
position indicator and 
the end of the clip.

1. In the Timeline, click in the middle of the Editor at keyboard clip.

2. Press and hold the Ctrl key and click between the position 
indicator and the beginning of the clip. The position indicator 
snaps to the first frame of the Editor at keyboard clip.

Splicing in the Clip

Now splice the clip into the sequence.

1. Click the Splice-in button on the Tool palette or press the V key on 
the keyboard.

Whenever you splice a clip into the middle of a sequence, the rest 
of the sequence is extended. Your Timeline should look like the 
one in the following illustration.

2. In the Timeline, press the Home key and play the sequence to 
review the new edit.

3. Close the Eyeball clip.
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Undoing an Edit

The Eyeball clip doesn’t seem to fit here. You can easily undo the edit 
by choosing Undo from the Edit menu or by pressing Ctrl+Z. Try it 
now.

You can also redo up to 
32 previous edits.

The Undo feature is very useful. You can undo up to 32 previous 
actions listed in the Edit menu.

Splicing in a Music Track

In this section, you lay down an audio clip that contains the music for 
the sequence. The music has already been edited to approximately 
1 minute, which is the length of the final sequence.

Opening and Marking the Clip

Open and mark the clip.

1. Open the Music track clip.

2. In the Source pop-up monitor, play some or all of the clip.

3. Click the Mark Clip button on the Source pop-up monitor.

Patching Tracks

Before you make the edit, look at the Track Selector panel.

Because the Music track clip has one audio track, the A1 button 
appears on the source side, directly across from the A1 button on the 
record side. If you make the edit now, the music will overwrite the 
narration.
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You need to tell the system to edit track A1 from the source clip to 
track A2 of the sequence. You do this by patching one track to another. 
The term patching comes from the electronics field, where it refers to 
temporarily connecting two components.

To patch the tracks, drag the pointer from the A1 button on the source 
side to the A2 button on the record side.

While you are patching, you see a white arrow connecting the two 
tracks. After the patch, you see that the button for source track A1 is 
next to the button for record track A2.

Selecting the Tracks to Edit
Look at the Track Selector panel again. You need to deselect all record 
tracks except A2. 

1. On the source side of the Track Selector panel, make sure track A1 
is selected (purple, not gray). 

2. On the record side of the Track Selector panel, make sure track A2 
is selected, and deselect all other video and audio tracks.

Splicing in the Clip

Now you’re ready to make the edit.

1. In the Timeline, go to the head of the sequence.

2. Click the yellow Splice-in button on the Tool palette.

The music track should now appear on track A2. Your sequence 
now has one video track and two audio tracks.



114

Reviewing Your Edits

Review what you’ve done.

1. Now that you have two tracks of audio, make sure that all tracks 
are being monitored. Make sure the Speaker icons for tracks A1 
and A2 are visible (see “Monitoring Tracks” on page 107).

2. Go to the head of the sequence and play through the sequence.

The music sounds a little loud for the narration. You’ll adjust audio in 
“Working with Audio” on page 133.

Confirming the Duration

The next steps explain how to confirm the duration by displaying the 
master timecode, which is the timecode of your sequence.

1. Look at the top left of the Composer window. If the master 
timecode (Mas) is not displayed, click and open the Tracking 
Information pop-up menu from the gray area above the Composer 
monitor and select Mas timecode.

The master timecode displays the location of the position indicator 
in your sequence.

2. Click the position indicator in the Timeline and drag it to the last 
frame of the sequence.
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The master timecode should read 00;00;59;00 (NTSC) or 
00:00:59:00 (PAL), which indicates that the sequence is 59 seconds 
long.

3. Drag the position indicator through the sequence and watch the 
master timecode change.

Now is a good time to close any open pop-up monitors. Close all bins 
too, except for the Sequences bin.

Next Steps

You’ve started your rough cut. You’ll adjust the audio in the next 
chapter. You’ll also add some clips to fill in the video gap and to 
illustrate what the narrator is talking about.

You can continue to the next chapter, or quit this session (see “Closing 
the Project and Quitting the Application” on page 68). The next time 
you open the project, the windows will be in the same position.
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CHAPTER 7

Building a Sequence

You’ve started creating your rough cut. Now you can complete the 
rough cut, trim your edits, and adjust the audio levels. In this chapter 
you’ll practice the following tasks:

• Storyboard Editing the Clips

• Overwriting Clips into a Sequence

• Backtiming an Edit

• Rearranging Clips

• Trimming

• Adding the Final Clip

• Working with Audio

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, choose your user name and 
the Introducing Avid project, and then click OK. If necessary, open the 
Sequences bin, and then drag the Rough Cut sequence into the 
Composer monitor.

If you have not worked on the previous chapters — Start the 
application, create a new user, choose the Introducing Avid project, 
and then click OK. Open the Sequences bin, and then drag the Rough 
Cut 1 sequence into the Composer monitor. Make sure you are familiar 
with marking IN and OUT points and performing splice-in edits.
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Storyboard Editing the Clips

Storyboarding allows you to set up a group of clips in a sequence of 
events, and then load them into the Composer monitor all at once.

Marking IN and OUT Points

The first step in storyboarding is to mark IN and OUT points for each 
of the clips you are going to use. We’ve already marked IN and OUT 
points for you. If you need to reset them, refer to the following table.

Clip Namea
IN Point 
(NTSC)

OUT Point 
(NTSC)

IN Point 
(PAL)

OUT Point 
(PAL)

Homicide logo 01:37:03:06 01:37:04:28 00:05:10:15 00:05:12:12

Newsroom 06;17;48;03 06;17;50;09 00:06:25:16 00:06:27:12

Editor at keyboard 2 01:26:59:00 01:27:01:04 00:02:37:18 00:02:39:23

Recording session 01:22:23:17 01:22:25:00 00:05:26:06 00:05:27:17

Special effects 01:01:40:20 01:01:42:21 00:03:28:15 00:03:30:15

Lab 1A 01:24:53:19 01:24:57:16 00:04:10:22 00:04:14:20

Lab 1B 01:25:00:11 01:25:07:16 00:04:17:03 00:04:25:12

Trade show 00;03;21;16 00;03;25;17 00:05:45:22 00:05:50:00

a. The NTSC version of these clips use either drop-frame timecode or 
non-drop-frame timecode, depending on how the original footage was 
shot. See “About Timecode” on page 85.
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Creating the Storyboard

Next you need to arrange the clips as a storyboard.

1. In the Source Clips bin, click the Frame View button.

2. If you need more space to view the clips, click the lower right 
corner of the bin and drag it to enlarge the window.

3. Choose Fill Window from the Bin menu to arrange the clips in the 
bin.

4. Arrange the following clips in two rows, from left to right, and top 
to bottom, to form the storyboard. You arrange the clips by 
clicking and dragging each clip. Make sure you maintain the order 
of clips as listed below and shown in the following illustration.

• Homicide logo

• Newsroom

• Editor at keyboard 2

• Recording session

• Special effects

• Lab 1A

• Lab 1B

• Trade show

Arranging the clips in this way makes it easier to select the clips 
you want to use in the storyboard. Separate the remaining clips, as 
shown in the following illustration.
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Editing the Clips into the Sequence

Now you’re ready to edit the marked clips into the sequence.

1. Click the Composer monitor, make sure Mas is displayed in the 
Tracking Information display, type 17;25 (NTSC) or 18:00 
(PAL), and press Enter on the numeric keypad.

2. Mark an IN point.

3. Select record track V1 and deselect all other video and audio 
tracks.
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4. Select the storyboarded clips all at once.

a. Position the pointer in the Source Clips bin in the blank area 
above and to the left of the Homicide logo clip.

b. Lasso the clips by clicking and dragging the pointer to the 
right and down, making sure to select all of the storyboarded 
clips, and then release the mouse button. After you select the 
clips, all the names are highlighted in blue.

5. Click on one of the clips (on the image, not the name), and drag 
the group into the Timeline. Release the mouse button when a 
yellow arrow appears in the Timeline.

The clips are spliced into the sequence in the order you specified.

6. Play the sequence to review it. 

Overwriting Clips into a Sequence

In the previous chapter, you spliced clips into a sequence. In this 
section you’ll learn how to overwrite clips into a sequence. An 
overwrite edit replaces a section of a sequence with other source 
footage. An overwrite edit is especially useful when you want to 
replace footage but you don’t want to affect the clips that follow in the 
sequence.



121

The Editor at keyboard clip is a little too long. Let’s edit the next clip 
over the last part of the Editor at keyboard clip. 

1. Make sure the Composer monitor is active.

2. Make sure the Mas timecode is displayed in the Composer 
monitor (see “Confirming the Duration” on page 114).

3. Mark an IN point at 00;00;07;08 (NTSC) or 00:00:07:06 (PAL). 

4. Open the Source Clips bin.

5. Open the Eyeball clip. 

6. Check the IN point and OUT points. If there are no points, see 
“Marking Another Clip” on page 83.

When you open a clip, 
source tracks are 
selected automatically.

7. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

8. Click the red Overwrite button on the Tool palette or press the B 
key on the keyboard.

The clip overwrites part of the Editor at keyboard clip.

9. Close the Eyeball clip.

Add two more short clips following the Editor at keyboard clip. Using 
the following clips and edit points, which you marked in Chapter 5, 
follow steps 5 to 9 in the previous procedure. Make sure the position 
indicator is parked on the last frame of the clip you just added.

Clip Name
IN Point 
(NTSC)

OUT Point 
(NTSC)

IN Point 
(PAL)

OUT Point 
(PAL)

Hand and keyboard 01:08:14:18 01:08:16:18 00:01:42:23 00:01:44:23

Editor at keyboard 3 01:23:24:02 01:23:27:00 00:03:07:15 00:03:10:13
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Backtiming an Edit

Backtiming an edit is effectively the reverse of the process you normally 
use for marking footage; instead of marking from the IN points 
forward, you mark from an OUT point backward.

In the sequence, there is a gap between the Editor at keyboard 3 clip 
and the Homicide logo clip. Let’s fill this gap.

1. Go to the last frame of black before the Homicide logo clip and 
mark an OUT point.

2. Go to the first frame of black after the Editor at keyboard 3 clip 
and mark an IN point.

The gap changes to purple.

3. Open the QuickTime Movies bin.

4. Open the Globe.mov clip.

5. Mark an OUT point at 00;00;04;17 (NTSC) or 00:01:09:10 (PAL).

6. Click the red Overwrite button on the Tool palette or press the B 
key on the keyboard.

The gap is now filled.

7. Close the Globe.mov clip and the QuickTime Movies bin.

Rearranging Clips

You can rearrange clips by overwriting material, switching placement 
of material, lifting material, or removing material. Overwriting and 
switching material doesn’t change the length of the sequence. Lifting 
material leaves a gap (also known as filler) and doesn’t affect the 
length of the sequence. Removing material shortens the length of the 
sequence.
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Overwriting with a Three-Point Edit

A three-point edit is an easy way to replace a clip in a sequence. Use the 
Mark Clip button to select the clip in the sequence (or mark an IN and 
OUT point for a segment that’s more than a single clip), and mark 
either the IN or OUT point in the source clip. The system calculates the 
exact duration of the source clip to insert.

Let’s replace the Editor at keyboard 3 clip near the beginning of the 
sequence with the L key clip.

1. To enlarge this area, in the Timeline:

a. Press the Home key.

b. Click the scale box and drag it to the right until you can read 
the label Editor at keyboard 3.

2. Place the position indicator anywhere in the Editor at keyboard 3 
clip.

3. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

4. Click the Mark Clip button in the row of buttons below the 
Composer monitor, or press the T key on the keyboard.

The IN and OUT points appear at the head and tail of the clip in 
the TC1 track of the Timeline. The marked segment changes to 
purple. 

The IN and OUT points also appear in the Composer monitor’s 
position bar.

5. In the Source Clips bin, open the L key clip.

6. Mark an OUT point at 01:11:40:15 (NTSC) or 00:02:03:04 (PAL). Do 
not mark an IN point.

Make sure the V1 timecode is showing in the Tracking Information 
display.
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7. Click the red Overwrite button on the Tool palette (or press the B 
key on the keyboard) to make the three-point edit.

The L key clip replaces the Editor at keyboard 3 clip.

8. Click the scale box and drag it to the left to contract the Timeline.

9. Close the L key clip.

Using Segment Mode

Segment mode provides editing controls for moving, deleting, 
marking, and editing entire segments in the Timeline. A segment is a 
portion of the sequence that consists of one or more clips. There are 
two buttons for editing segments or adding clips: Extract/Splice-in 
(indicated by a yellow arrow) and Lift/Overwrite (indicated by a red 
arrow). These buttons are located at the bottom of the Timeline 
window.

Unlike traditional editing, Segment mode allows you to reposition 
entire segments instantly by using visual controls as though you were 
physically “dragging” portions of your sequence around on a tape. 
You can move clips separately or together, and on one track or across 
tracks.

Changing the Order of Clips in a Sequence

Let’s see what it looks like if we reverse the position of two clips in the 
sequence. To move entire clips, use Segment mode.

1. Make sure the position indicator is parked in the L key clip (the 
one you just edited into the sequence).

Extract/Splice-in button Lift/Overwrite button
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2. Click the Segment Mode (Extract/Splice-in) button, which is the 
button with the yellow arrow under the Timeline.

When the button is activated, its background changes to light gray.

c Don’t confuse the Extract/Splice-in and Splice-in buttons. The 
Extract/Splice-in button is located under the Timeline; the Splice-in 
button is located on the keyboard (the V key) and on the Tool 
palette.

3. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

4. Click the L key clip, drag it to the left (so it is over the preceding 
clip), and release the mouse button. 

The L key clip should now follow the Eyeball clip.

5. Click the Extract/Splice-in button again to deselect it.

6. Click the Timeline anywhere in the Eyeball clip and review the 
clips you just moved.

Let’s go back to the original order. Choose Undo from the Edit menu.

Removing Footage from a Sequence

You can remove footage from your sequence, and either close or retain 
the gap that results. The Delete key closes the gap, and the Lift key 
retains the gap.

Removing Footage and Closing the Resulting Gap

The Editor at keyboard 2 clip that was part of the storyboard is too 
similar to the clips at the beginning of the sequence. Let’s remove it 
from the sequence and close the gap that results.

1. Use the scale bar and scroll bar to locate the Editor at keyboard 2 
clip.
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2. Click the yellow Segment Mode (Extract/Splice-in) button under 
the Timeline.

To eliminate footage 
that does not start and 
end at a transition, use 
IN and OUT points to 
mark the segment that 
you want to extract. 

3. Click anywhere in the Editor at keyboard 2 clip on track V1.

The clip is highlighted.

4. Press the Delete key on the keyboard.

The selected clip is eliminated and the surrounding clips close the 
gap.

5. Deselect the Extract/Splice-in button by clicking it.

6. Click the Timeline in front of the Recording session clip and play 
the next few clips.

The video no longer matches the narration. You need to retain 
rather than close the gap.

7. Choose Undo from the Edit menu to undo the edit and restore the 
clip.

Removing Footage and Retaining the Resulting Gap

The Lift key retains the gap after lifting footage from the sequence. Use 
the Lift key if you want to maintain the rhythm of a sequence or the 
synchronization of the video and audio tracks.

Try the edit again, but this time use the Lift key, and replace the clip.

1. Click anywhere in the Editor at keyboard 2 clip.

2. Click the Mark Clip button below the Composer monitor to mark 
IN and OUT points.

3. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.
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4. Press the Lift key on the keyboard to remove the segment.

The letter equivalent of the Lift key depends on the version of 
your keyboard. For the location of the Lift key, choose Keyboard 
from the Settings scroll list.

The selected segment lifts out and leaves filler in its place.

Replacing a Clip

Now fill the gap with a different clip.

1. Open the Corporate editor clip.

2. Mark an IN point for the clip at timecode 06;16;34;13 (NTSC) or 
00:06:08:07 (PAL).

3. In the sequence, make sure the filler has IN and OUT points. If not, 
click the Mark Clip button.

4. Click the red Overwrite button on the Tool palette or press the B 
key on the keyboard.

The filler has been replaced by the new clip.

5. Close the Corporate editor clip and the Source Clips bin.

6. Move the scale bar all the way to the left to compress the Timeline, 
which lets you see the entire sequence.

Trimming

Trimming allows you to adjust incoming and outgoing frames of your 
clip. There are two types of trims: dual-roller and single-roller. When 
you trim, you are working in Trim mode. In Trim mode the Composer 
monitor changes and new editing buttons appear.

To trim a transition, at least one of the clips needs media in addition to 
the media displayed in the Timeline (see “Sequences” on page 42).
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Adjusting Both Sides of a Transition (Dual-Roller Trimming)

Use a dual-roller trim to adjust both sides of a transition at the same 
time, adding frames to one clip while subtracting frames from the 
adjacent clip. The total duration of the sequence does not change.

Let’s tighten the Lab 1A/Lab 1B transition. (You’ll smooth the 
transition with a dissolve effect in the next chapter).

1. Place the position indicator near the Lab 1A/Lab 1B transition, 
and click the Trim Mode button on the Tool palette.

The position indicator snaps to the transition, and an icon 
representing two rollers appears.

The Composer monitor shows the last (tail) frame of the Lab 1A 
clip on the left, and the first (head) frame of the Lab 1B clip on the 
right.

New buttons appear below the trim windows. During a dual-
roller trim, both frame counters are purple.

 

Dual-roller icon
at the trim transition
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2. Play the transition by clicking the Play Loop button.

The transition plays repeatedly.

3. To stop the playback loop, click the Play Loop button again.

4. Click the Trim Left 10 Frames button three times.

Transition Effect
palette

Outgoing clip Incoming

Frame
counters

Trim Frame buttons buttonPlay Loop

clip

 

Trim Right
10 Frames

Trim Right
1 Frame

Trim Left
1 Frame

Trim Left 
10 Frames
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You can also trim by 
dragging the Dual-
Roller icon.

This action adds 30 frames to the head of the incoming clip and 
removes 30 frames from the tail of the outgoing clip. The duration 
of the video track remains unchanged.

5. Play the transition again by clicking the Play Loop button.

6. Do one of the following to exit Trim mode:

• Click the Trim Mode button on the Tool palette.

• Press the Left Arrow key on the keyboard.

Single-Roller Trimming

In the previous trim, you trimmed both the head and the tail clips an 
equal number of frames, adding to one side and subtracting from the 
other. Now let’s trim the tail of one clip without affecting the head of 
the next clip. This is a single-roller trim. You’ll also use a different way 
of entering Trim mode.

The Trade show clip begins a little too quickly for the narration. Let’s 
extend the Lab 1B clip while keeping the same start of the Trade show 
clip.

1. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

2. Move the position indicator to the Lab 1B/Trade show transition.

3. Enter Trim mode by lassoing the Timeline tracks.

a. Click the pointer above all the Timeline tracks, just to the left 
of the transition, but below the title bar. In this example, click 
above and to the left of the position indicator. 

 

Click here to
lasso the
transition.
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b. Drag the pointer down and to the right to surround the
transition, and release the mouse button.

The trim rollers appear.

4. In the Composer window, click the left frame counter (A-Side Trim 
counter).

Your trim will only affect the outgoing clip, which is in the left 
Trim monitor. The left frame counter remains purple, while the 
right one is deselected. A single roller appears in the Timeline.

5. On the numeric keypad, type +40 and press Enter.

This moves the transition 40 frames to the right.

Left frame
counter
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6. Play the transition by clicking the Play Loop button.

7. Exit Trim mode by pressing the Left Arrow key on the keyboard or 
by clicking the Trim Mode button on the Tool palette.

Adding the Final Clip

We have supplied you with another QuickTime movie, titled Closing 
logo.mov. This clip needs to be edited to sync with the music, so use 
timecode to set the IN point in the sequence. 

1. Open the QuickTime Movies bin.

2. Open the Closing logo.mov clip.

3. Click the Mark Clip button to mark the entire clip for editing.

4. Click the Composer monitor.

5. Mark an IN point at 00;00;44;02 (NTSC) or 00:00:44:02 (PAL).

Use the Mas setting in the Tracking Information display.

6. In the Track Selector panel, make sure record track V1 is selected, 
and all other video and audio tracks are deselected.

7. Click the Overwrite button or press the B key to make the edit.

8. Close the Closing logo.mov clip and the QuickTime Movies bin.

9. Play your sequence to review your work.

There might be a small gap between the end of the Trade show clip 
and the beginning of the Closing logo.mov clip. 
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Perform a dual-roller trim to close the gap.

1. Place the position indicator on the first frame of black after the 
Trade show clip and click the Trim Mode button on the Tool 
palette.

You should see two rollers appear at the transition.

2. Drag the rollers until they reach the beginning of the Closing 
logo.mov clip.

The rollers will stop when they reach the beginning of the next 
clip.

3. Click the Left Arrow key to exit Trim mode.

4. Play the last two clips of the sequence.

Working with Audio

In this section, you work with the Audio Mix tool to adjust the balance 
and volume of the sequence. 

Adjusting Audio Pan (Balance)

The narration for the sequence plays out of one speaker and the music 
plays out of another. You can adjust the audio pan (balance) so the 
sound plays equally from both speakers.

1. Clear any IN or OUT points from the sequence by pressing the G 
key on the keyboard.

2. Select record tracks A1 and A2.

3. Move the Timeline position indicator to any point in the Timeline 
that includes both A1 and A2.

4. Choose Audio Mix from the Tools menu.

The Audio Mix tool appears.
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5. Click and hold the Pan Level box for track A1 to open the Pan 
Adjustment window.

The Pan slider appears.

To snap the slider to 
MID, press and hold the 
Alt key and click the 
Pan Level box.

6. Drag the Pan slider to the middle of the scale until it reads MID, 
and then release the mouse button.

7. Open the Pan Adjustment window for track A2 and drag the Pan 
slider until it reads MID. Release the mouse button.

You can change the pan 
settings for an entire 
project in the Audio 
Settings dialog box.

8. Play a portion of the sequence to check the speaker balance.

Level sliders

Pan Level boxes

Drag the Pan slider.

Click and hold here to 
open the Pan
Adjustment window.
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Adjusting Audio Level

The music is a little loud for the narration. Let’s raise the volume of the 
narration by using the Audio Mix tool. 

1. The Audio Mix tool should already be open. If not, choose Audio 
Mix from the Tools menu.

2. Place the position indicator anywhere within the Narration clip.

3. In the A1 area of the Audio Mix tool, move the A1 Audio Level 
slider to level +5.0 by doing one of the following:

• Drag the slider to level +5.0.

• Click the slider and type +5.

• Click the slider and press the Up Arrow or Down Arrow key 
on the keyboard to reach level +5.0.

4. Play a portion of the sequence.

Adjust the audio level further, depending on your preference.

5. Click the Close button to close the Audio Mix tool.

You can make further adjustments to the narration or music track by 
using the Audio Gain Automation tool. See the Avid Xpress DV User’s 
Guide or Help.

Next Steps

You’ve completed and refined your rough cut. You can continue to the 
next chapter to add effects, or quit this session (see “Closing the 
Project and Quitting the Application” on page 68). The next time you 
open the project, the windows will be in the same position.
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CHAPTER 8

Adding Effects

Adding an effect to a clip enhances your sequence by fading in or out 
of a scene, or adding video or a graphic on top of a clip. In this chapter, 
you’ll add dissolves and other effects. This chapter covers the 
following topics:

• Effects Editing

• Dissolving Between Clips

• Adding a Picture-in-Picture Effect

• Adding a Flop Effect

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, choose your user name and 
the Introducing Avid project, and then click OK. If necessary, open the 
Sequences bin, and then drag the Rough Cut sequence into the 
Composer monitor.

If you have not worked on the previous chapters — Start the 
application, create a new user, choose the Introducing Avid project, 
and then click OK. Open the Sequences bin, and then drag the Rough 
Cut 2 sequence into the Composer monitor. 
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Effects Editing

The Avid Xpress DV system offers many effects that you can apply to 
your sequences. This chapter explains how to apply effects to 
transitions or segments (clips) in your sequence. After you have 
selected the effect and have applied it to a transition or segment, you 
can adjust the effect parameters to meet your requirements.

Effects need to be rendered before you play them in the finished 
sequence. Rendering an effect creates a media file that plays with the 
sequence. You can preview effects before rendering by “stepping 
through” the sequence using the Step keys.

Some effects can be applied only to transitions, other effects can be 
applied only to segments, and some effects can be applied to both 
transitions and segments. In addition, some effects can be applied to a 
single video layer, and others to multiple video layers.

For complete explanations of effects and how to use them, see the 
Avid Xpress DV Effects Guide.

Transition Effects

A transition is the point where two clips meet. You apply a transition 
effect to the cut point between two clips on the same video track. After 
you apply a transition effect, you can adjust its relative position and 
duration. Depending on the specific effect, other effect parameters 
might apply.
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Segment Effects

You apply a segment effect to an entire clip or a group of clips. There 
are two types of segment effects:

• A single-layer segment effect, such as a mask or a flop, is applied to a 
segment on one video track.

• A multilayer segment effect, such as a Picture-in-Picture effect, is 
applied to the top layer of segments that contain two or more 
video tracks that will be played simultaneously.

You’ll add both types of effects in this chapter.

Dissolving Between Clips

Let’s start by adding a dissolve between two clips of the sequence. A 
dissolve is a video or audio transition in which an image from one 
source gradually becomes less distinct as an image from a second 
source replaces it.

1. Clear IN or OUT points if they are marked on the sequence.

2. Select record track V1 and deselect all other video and audio 
tracks.

3. Click the transition between the Editor at keyboard clip and the 
Eyeball clip.

4. Click the Add Dissolve button on the Tool palette. 

The Quick Dissolve dialog box appears.
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5. Let’s make the dissolve a little shorter than the default duration. 

a. Choose Dissolve from the Add pop-up menu.

b. Choose Centered on Cut from the Position pop-up menu.

c. Type 20 (NTSC) or 16 (PAL) in the Duration text box. The 
number 10 or 8 automatically appears in the Start text box.

6. Choose the drive on which the effect media file should be stored 
from the Target Drive pop-up menu. 

Boldface indicates the drive with the most space. The Film Clip 
icon indicates the drive that holds the media for the outgoing clip 
in the transition. For this tutorial, select the drive that holds the 
media.

7. Click the Add and Render button to render the effect.
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A message box appears while the system creates a media file for 
the effect. A progress indicator displays the percentage of the 
rendering that has been completed. After the effect is created, a 
rendered effect icon appears in the Timeline where you added the 
effect.

8. Play the effect. Press the space bar to stop playback.

Creating a Series of Dissolves

After you create one dissolve, you can quickly add it to other 
transitions in a sequence. Add the same dissolve you created in the 
previous section to smooth the other three transitions in the opening 
part of the sequence.

1. In the sequence, mark an IN point in the Eyeball clip, before the 
transition to the Hand and keyboard clip.

2. Mark an OUT point in the Globe.mov clip, after the transition. 
The IN and OUT points should include three transitions.

3. Click the Add Dissolve button.

The dialog box contains the same parameters you used to create 
your dissolve.

4. Select the option Apply To All Transitions (In -> Out). 

5. Click Add.

The system adds the effects, but does not render them. The blue dots 
on the effect icons indicate that you need to render the effects. You can 
save time by adding effects and rendering them later. 

Rendered effect icon

Blue dots
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Rendering a Series of Effects

Now render the three dissolves you just created.

1. Make sure the sequence contains the IN and OUT points you 
marked in the previous procedure.

2. Choose Render In/Out from the Clip menu.

The Render Effects dialog box appears.

3. For the Target Drive, choose the same drive that you selected in 
“Dissolving Between Clips” on page 138. This drive will remain 
the default target drive until you choose another.

4. Click OK.

The message box with a progress indicator appears. To see the 
progress of rendering, press the T key.

After the effects are rendered, the blue dots no longer appear on 
the effect icons.

5. Play the first part of the sequence to review your work.
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Adding Additional Dissolves

Now add two more dissolves.

1. In the sequence, mark an IN point in the Lab 1A subclip, before 
the transition to the Lab 1B subclip.

2. Mark an OUT point in the Trade show clip, just after the transition 
from the Lab 1B subclip.

3. Click the Add Dissolve button.

4. Select the option Apply To All Transitions (In -> Out).

5. Click Add and Render.

The system adds and renders the effects.

Changing the Position of a Dissolve

When Avid Xpress DV creates a dissolve between two clips, it needs 
media in addition to the media displayed in the Timeline. This 
additional source media (or handles) must be part of the master clip 
(see “Sequences” on page 42). Let’s create a dissolve when one clip 
doesn’t have enough extra source media.

1. Click the transition between the Trade show and Closing 
logo.mov clips.

2. Click the Add Dissolve button.

The Quick Dissolve dialog box appears with a message that tells 
you that the incoming clip, in this case Closing logo.mov, doesn’t 
have enough additional media to create a dissolve that is centered 
on the cut.
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3. Choose Starting at Cut from the Position menu.

The message disappears, because in this case the system will use 
additional media from the Trade show clip to create the dissolve.

4. Click Add and Render.

5. Play the transition.

The system created an acceptable dissolve.

Adding a Picture-in-Picture Effect

Let’s add an effect that illustrates the narration. Using a Picture-in-
Picture effect, you’ll show footage of a test engineer over the Lab 1A/
Lab 1B transition.
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Displaying the Effect Palette

Before you add your next effect, choose Effect Palette from the Tools 
menu. The Effect Palette appears.

The Effect Palette contains most of the effects in the Avid Xpress DV 
system. The exceptions are motion effects that you access from the Fast 
menu on a Source pop-up monitor, the Freeze Frame effect that you 
access from the Clip menu, and titles that you create with the Title tool. 

You’ll be choosing Picture-in-Picture from the Effect Palette.

Using the Second Video Track 

A Picture-in-Picture effect takes up two video tracks: in this sequence, 
V1 for the lab footage and V2 for the test engineer. First, you have to 
edit the Testing board clip onto track V2.

1. Select record track V2 and deselect all other video and audio 
tracks.

2. Press the G key to clear IN and OUT points from the sequence. 
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3. Mark an IN point at 00;00;00;30 (NTSC) or 00:00:00:30 (PAL). 
Check the Mas timecode display in the Composer monitor to help 
you mark the IN point.

4. Open the Source Clips bin and open the Testing board clip.

5. Mark an IN point at 01:14:36:00 (NTSC) or 00:04:49:01 (PAL) and 
an OUT point at 01:14:39:18 (NTSC) or 00:04:52:19 (PAL).

6. Patch the V1 source track to the V2 record track by clicking the V1 
Source Track button and dragging it to the V2 Record Track button 
(see “Patching Tracks” on page 112).

7. Click the Overwrite button.

The clip is edited onto track V2.

8. Close the Testing board clip and the Source Clips bin.

9. Play the edited section of the sequence from a location before the 
Testing board clip.

Creating the Picture-in-Picture Effect

Let’s place the new clip in a window by using the Picture-in-Picture 
effect.

1. Make sure record track V2 and the record track V2 monitor are 
selected.

2. Click the Effect Palette or choose it from the Tools menu.

3. Select Blend from the list of effect categories on the left side of the 
Effect Palette.

The blend effects, including the Picture-in-Picture effect, are 
displayed on the right side of the Effect Palette.
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4. Place the position indicator anywhere in the Testing board clip on 
track V2.

5. Click the Picture-in-Picture icon from the Effect Palette and drag it 
to the Testing board clip.

The Picture-in-Picture icon appears in the Timeline.

The Testing board clip appears in a box in the middle of the 
Composer monitor.

Picture-in-Picture icon
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n If the foreground image does not appear midscreen, make sure to choose
Render On-The-Fly from the Clip menu. A check mark should appear in front 
of the menu choice.

6. Close the Effect Palette.

Resizing the Image

Now let’s enter Effect mode and enlarge the image slightly.

1. In the Timeline, make sure the position indicator is directly over 
the Picture-in-Picture icon.

2. Click the Effect Mode button on the Tool palette to enter Effect 
mode.

The Effect Editor appears, with parameters for the Picture-in-
Picture effect.

Foreground Background
filler (V1)image (V2)
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In Effect mode, the Composer monitor changes to include only the 
duration of the effect, with keyframe markers (pink triangles) at 
the beginning and end of the clip. For more information about 
using keyframes, see the Avid Xpress DV Effects Guide or Help.
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3. In the Effect Editor, click the arrow next to the word Scaling to 
open the scaling pane.

4. Click the Fixed Aspect button to keep the image at the same 
proportions. Make sure the button changes to pink.

5. Click either the Wid (Width) or Hgt (Height) slider so that the 
slider changes to pink.

You can also drag the 
slider.

6. Press the Right Arrow key on the keyboard 10 times. Both the 
height and width change.

Keyframe markers

Width slider
Height slider

Fixed Aspect button
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Previewing the Effect
You can preview the effect before you render it by clicking the Play 
Loop button on the right side of the Effect Editor. The clip with the 
effect plays from beginning to end until you click the button again.

n If you are in Effect mode, you can also click the Play button to preview the 
effect. Outside of Effect mode, you need to render the effect before you can 
view it.

Adjusting the Border

You can add to the effect by softening the border.

1. Click the Soft slider in the Effect Editor.

You can also drag the 
slider or use the arrow 
keys.

If you can’t see the Effect Editor, click the Effect Mode button on 
the Tool palette.

2. Type 10 on the numeric keypad.

You can see the borders soften. 

Soft slider
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Fading In and Out

The Picture-in-Picture appears and disappears suddenly. There’s a 
special button you can use to fade the effect in and out.

1. On the Tool palette, click the Fade Effect button.

The Fade Title Effect dialog box appears.

2. Click in the Fade Up text box and type 10. Do the same for the 
Fade Down text box.

3. Click OK.

You won’t see the fade until you render the effect.

Rendering the Effect

Now it’s time to render the effect. 

1. On the Tool palette, click the Render Effect button.

The Render Effect dialog box appears.

2. Accept the default target drive and click OK. 

A message box with a progress indicator appears. Because this 
effect is more complex than a dissolve, it will take a little longer to 
render (approximately 1 minute).To check the time elapsed and 
time remaining, press the T key.
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3. When the rendering is complete, close the Effect Editor to exit 
Effect mode.

4. Play the part of the sequence that includes the Picture-in-Picture 
effect.

Adding a Flop Effect

In the Eyeball clip, the letters of the word Avid are reversed, as if 
reflected in a mirror. You can use the Flop effect to display the letters in 
the normal way.

1. Open the Effect Palette.

2. In the left column, click Image.

3. In the right column, click Flop and drag the icon to the Eyeball 
clip in the Timeline.

4. Close the Effect Palette.

5. Click anywhere in the Eyeball clip.

The image is now reversed, or flopped.

This effect, and the dissolves on either side, have blue dots and 
need to be rendered. Even though you rendered the dissolves 
earlier, placing another effect on top of them requires you to 
render all three effects.

6. Select record track V1 and deselect all other video and audio 
tracks.

7. In the sequence, mark IN and OUT points that include all three 
effects.

8. Choose Render In/Out from the Clip menu.

The Render Effects dialog box appears.
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9. Click OK.

10. Play the part of the sequence that includes the effects you just 
rendered.

Next Steps

You’ve finished adding effects to the sequence. If you want, you can 
take time to play with other effects, such as adding more dissolves, 
changing the border of the picture-in-picture, or experimenting with 
transition effects like edge wipes. In the next chapter you’ll add a title. 
You can continue to the next chapter, or quit this session (see “Closing 
the Project and Quitting the Application” on page 68). 
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CHAPTER 9

Creating Titles

The Title tool lets you create text and graphics that you can edit into a 
sequence. In this chapter you’ll add titles to your sequence by 
completing the following tasks:

• Creating a New Title

• Saving a Title

• Editing the Title into the Sequence

• Fading a Title

• Editing a Saved Title

• Renaming Your Sequence

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, choose your user name and 
the Introducing Avid project, and then click OK. If necessary, open the 
Sequences bin, and then drag the Rough Cut sequence into the 
Composer monitor.

If you have not worked on the previous chapters — Start the 
application, create a new user, choose the Introducing Avid project, 
and then click OK. Open the Sequences bin, and then drag the Rough 
Cut 3 sequence into the Composer monitor. 
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Creating a New Title

For complete 
information on creating 
and editing titles, see 
the Avid Xpress DV 
Effects Guide or Help.

Let’s create a title that illustrates part of the narration.

1. In the Timeline, place the blue position indicator in the middle of 
the Testing board clip.

2. Choose New Title from the Clip menu.

The Title Tool window opens on top of the Composer and 
Timeline windows.

Toolbar

Safe action
area

Video
background

Safe title
area
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The Title tool includes the following features:

To get information on 
items in the toolbar, 
position the pointer on 
an object, click the right 
mouse button, and 
choose What’s This? 
from the pop-up menu.

• Two grids that indicate areas of the image that are safe for 
broadcast. The outside grid outlines the safe action area and 
the inside grid outlines the safe title area. The safe title and 
safe action areas do not apply if you are creating a video for a 
CD-ROM or the Internet.

• Video background for the title, based on the location of the 
position indicator when you open the Title tool.

• A toolbar that includes many controls for creating, adjusting, 
and saving your titles.

3. Click the Text Tool button. If it is already selected on the toolbar, 
the pointer changes to an I-beam when you click in the Title Tool 
window.

4. Click in the left side of the safe title area, below the picture-in-
picture.

A blinking insertion point appears.

5. Type product innovation.

6. The following values might already be selected. If not:

a. Click the Selection Tool button on the toolbar, then click the 
title text.

Object selection handles surround the title.

b. Choose 48 from the Font Point Size pop-up menu.

c. Choose Arial from the Font Selection pop-up menu.

d. Click the B button for bold and click the I button for italics.

Adding a Shadow
Adding a shadow to the title text will make it easier to read. Type a 5 
in the Shadow Depth Selection text box and press the Enter key.
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By default, the Title tool uses a shadow that falls below and to the right 
of the text. For more information about changing the type of shadow 
and how it falls, see the Avid Xpress DV Effects Guide.

Positioning and Aligning Text

You might need to move the text so that it aligns with the edge of the 
safe title grid.

1. Select the first line of text.

2. Choose Align to Frame Left from the Alignment menu.

Your title should look similar to the one in the following illustration.
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There are many adjustments you can make in the Title tool. For now, 
let’s save the title.

Saving a Title

Now save your title.

1. Open the Source Clips bin. You’ll be storing the title here.

2. Click in the Title Tool window.

3. Choose Save Title from the File menu.

The Save Title dialog box appears.

4. Type product innovation in the Title Name text box.

5. Choose Source Clips from the Bin pop-up menu.

6. Accept the default drive and resolution.

7. Click Save.

The title appears in the Source Clips bin.

8. Click the Close button to close the Title tool. 

Editing the Title into the Sequence

Now add the title to your sequence.

1. Double-click the product innovation title clip.

The title opens in a Source pop-up monitor. 

2. Add a new video track (V3) by choosing New Video Track from 
the Clip menu.
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3. Patch source track V1 to record track V3 by clicking the V1 Source 
Track button and dragging it to the V3 Record Track button (see 
“Patching Tracks” on page 112).

4. Make sure source track V1 and record track V3 are selected, and all 
other video and audio tracks are deselected.

5. In the Source pop-up monitor, set an IN point at the beginning of 
the clip.

6. In the Timeline, set an IN point at 00;00;31;22 (NTSC) or 
00:00:31:22 (PAL) which is approximately where the narrator 
begins to say “product innovation.”

7. Set an OUT point at 00;00;33;19 (NTSC) or 00:00:33:19 (PAL) to 
sync with the end of the Testing board clip.

8. Click the red Overwrite button on the Tool palette.

This adds the title to the V3 video track. Now you have to render 
the title, in the same way as you would render an effect.

9. In the Timeline, place the position indicator on the Title Effect icon.

10. On the Tool palette, click the Render Effect button and click OK.

The Avid Xpress DV system renders the effect and creates a file for 
the title.

11. Close the product innovation title clip.

12. Play the part of the sequence that includes your title.

Fading a Title

You can have the title fade in and out:

1. Place the position indicator on the Title Effect icon.

2. Click the Fade Effect button on the Tool palette.

3. Type 10 frames in each of the text boxes.
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4. Click OK.

The effect now has a blue dot. You need to render the effect again.

5. Click the Render Effect button and click OK.

6. Play your sequence from just before the Testing board clip.

Editing a Saved Title

You can edit a saved title to change the content, font, and so on. You 
can create a new title by editing a saved title and saving it with a new 
name. 

1. In the Source Clips bin, Ctrl+double-click the product innovation 
title.

The title opens in the Title Tool window.

2. Make sure the Text Tool button is selected.

3. In the Title Tool window, click the beginning of the existing title 
and drag the cursor to select the text.

4. Replace the text with the words a path to the future. Keep 
the same settings as the previous title.

5. Click the Selection tool and then drag the title to the upper right.

6. Choose Align to Frame Right from the Alignment menu.

Changing Color
By default, the text is white. Let’s change the color of the new title.

1. Click the Selection tool and then click the title text.

2. Click and hold the Fill box. 

The Title Tool Color Picker appears.
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You can “tear off” the 
Title Tool Color Picker 
window by dragging it 
to another location.

3. Drag the mouse pointer over the band of colors at the top of the 
Title Tool Color Picker. When you find a color you want to use, 
release the mouse button

The color is applied to the title.

Saving the Title

Next, save the title with a different name.

1. Choose Save Title As from the File menu.

2. In the Title Name text box, type a path to the future.

3. Click Save.

4. Close the Title tool.

Editing the Title

Now edit the title into the sequence in the same way that you edited 
the previous title.

1. Open the a path to the future clip.

2. Click the Timeline and mark an IN point at 00;00;35;19 (NTSC) or 
00:00:35:19 (PAL), approximately where the narrator begins to say 
“a path to the future.”

3. Mark an OUT point at 00;00;37;15.

4. Patch source track V1 to record track V3.

5. Click the red Overwrite button on the Tool palette.

6. Click the Fade Effect button.
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7. Render the title.

8. Play the sequence from the beginning to review your work.

Renaming Your Sequence

If you’re satisfied with your sequence, change the name from Rough 
Cut to a name of your choice.

1. In the Sequences bin, click the name Rough Cut.

2. Type a new name, such as Final Sequence.

Next Steps

You’ve finished editing your sequence. There are probably changes 
and refinements you’d like to make. If you have time, try making these 
changes. Consult the Avid Xpress DV User’s Guide, Avid Xpress DV 
Effects Guide, and the Help for information on all the features of the 
product and how to use them.

The next chapter describes how to output your sequence. You can 
continue to the next chapter, or quit this session (see “Closing the 
Project and Quitting the Application” on page 68).
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CHAPTER 10

Generating Output

You’ve finished your sequence. Now you’re ready to create an output 
format and distribute it. Avid Xpress DV lets you output your 
sequence in many different formats. This chapter covers three kinds of 
output:

• Creating a Movie for the Internet

• Exporting a QuickTime Movie

• Outputting a Digital Cut to Tape

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, choose your user name and 
the Introducing Avid project, and then click OK. If necessary, open the 
Sequences bin, and then drag your final sequence into the Composer 
monitor.

If you have not worked on the previous chapters — Start the 
application, create a new user, choose the Introducing Avid project, 
and then click OK. Open the Sequences bin, and then drag the 
Introducing Avid sequence into the Composer monitor. 
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Creating a Movie for the Internet

Avid Xpress DV includes software that is especially designed for 
creating video that is formatted for distribution over the Internet. 
These formats include:

• RealMedia™ G2

• MPEG - Ligos

• Microsoft® ASF

• QuickTime

This section describes how to use the RealProducer G2 application to 
output a RealMedia movie. For information about other formats, see 
the Avid Xpress DV User’s Guide and Help.

n Software for these applications is installed when you install Avid Xpress DV 
software. You can also install the applications separately. See
“Installing Avid Xpress DV Software” on page 24.

About RealMedia

RealMedia, developed by RealNetworks, Inc., is a streaming format. 
Streaming is a technology in which viewers can watch a video clip or 
movie over the Internet while it is being copied to their computer, 
rather than forcing them to wait until the entire file is downloaded.

Avid Xpress DV and RealProducer G2 convert your sequence to a 
streaming movie for viewing over a network or the Internet. To view a 
RealMedia movie, you need RealPlayer® software, which is installed 
with Avid Xpress DV. You can also download RealPlayer from the 
RealNetworks Web site at www.real.com.
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Preparing the Sequence

Before you export your sequence, check the sequence to make sure 
you have selected and monitored the tracks you want to use.

1. Start Avid Xpress DV and open your final sequence (or you can 
use the prepared sequence titled Introducing Avid).

2. Make sure the Track Selector panel has the following record tracks 
selected and monitored:

• V3

• V2

• V1

• A1

• A2

Track selector buttons for these tracks should be purple. Track 
Monitor buttons should show a Monitor icon for track V3 and 
Speaker icons on tracks A1 and A2.

3. Clear any IN or OUT points in the sequence.

4. If you want, play some or all of the sequence to make sure it is the 
version you want to output.

Creating a RealMedia Movie

Now you’re ready to create the RealMedia movie. 

For complete 
information about 
exporting, see the 
Avid Xpress DV User’s 
Guide or Help.

1. In the Sequences bin, select your final sequence.

2. Choose Export from the File menu.

The Pick Export Settings dialog box appears.
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The Export pop-up menu shows the Export settings that are in the 
Settings scroll list. In this example, Untitled is the name of the 
default setting. 

The Settings scroll list includes export templates that make the 
export process easier. In this example, you’ll use one of these 
templates.

3. Choose RealMedia G2 from the Export pop-up menu.

4. Click OK.

The Export As dialog box appears. 

5. Select a location for the RealMedia movie.

For this tutorial, the RealMedia movie requires approximately 
2.2 MB of disk space.

6. Click Save.

The Avid Xpress DV system creates an intermediate movie. When 
the processing is complete (for this tutorial, it takes approximately 
1 minute), the first dialog box for RealProducer G2 appears.

n Avid Xpress DV saves the intermediate movie in a temporary folder. Make 
sure the temporary folder is on a drive with sufficient space, typically a drive 
other than drive C. You can view and change the location in the General 
Settings dialog box, which you access from the Settings scroll list.
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For complete 
information on using 
RealProducer G2, click 
the Help button.

7. Enter information about your RealMedia clip in the text boxes. 
This information is optional. If you include the information, it will 
appear in the RealPlayer when your movie is playing.

Click Next. The File Type dialog box appears.
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8. Select the type of RealMedia file that you will create. For this 
tutorial, select SureStream. 

SureStream allows you to create a single RealMedia clip that can 
play across a variety of different connections. To take advantage of 
SureStream technology, you must broadcast the clip using 
RealServer G2.

Click Next. The Target Audience dialog box appears.
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9. Select the modem or connection speed of the target audience. For 
this tutorial, select 56 Kbps Modem and Corporate LAN. The more 
options you select, the larger your file becomes. RealNetworks, 
Inc. recommends that you select only three or four options.

The maximum size of your output video image depends on the 
target audience you select. For information about maximum 
output sizes, click the Help button.

You can customize the target audience settings by clicking the 
Settings button. For this tutorial, accept the default settings.

When you have selected your options, click Next. The Audio 
Format dialog box appears.
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10. Select Voice with Background Music and click Next.

The Video Quality dialog box appears.
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11. Select Normal Motion Video and click Next.

The Save Settings dialog box appears.

12. Review the options you have selected. If you are satisfied, click 
Finish. 

Your sequence is exported as a RealMedia file. For this tutorial 
sequence, the process takes approximately 6 minutes. When the 
export is finished, the Conversion Complete dialog box appears.
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13. Click the Play button to view your RealMedia movie. 

The movie appears in the RealPlayer. 

You might need to minimize the Avid Xpress DV window to view 
the RealPlayer.
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For complete information about using the RealPlayer, choose an 
option from the RealPlayer Help menu.

For information about creating and publishing a Web page, see the 
RealProducer G2 Help.



174

Exporting a QuickTime Movie

Avid Xpress DV provides you with many options for outputting 
(publishing) your sequence in formats suitable for digital distribution. 
In this section, you’ll create a QuickTime movie, which is a format you 
can use for distribution on CD-ROM or over the World Wide Web. For 
information about using other formats, see “Creating a Movie for the 
Internet” on page 164, the Avid Xpress DV User’s Guide, or Help.

Using the QuickTime DV Codec

To create the QuickTime movie, you’ll be using the DV codec that is 
built into the QuickTime software. A codec is software or hardware that 
compresses and decompresses digital media (the word codec is a 
combination of the words compressor and decompressor). The 
QuickTime DV codec creates media files that are readable within 
QuickTime applications. In the following procedure, the codec uses 
the size, resolution, and other parameters of the Avid Xpress DV 
sequence, which makes the export very fast.

When you select the Same as Source option, the QuickTime DV codec 
maintains the dimensions of the media (720 x 480 pixels for NTSC,
720 x 576 pixels for PAL), which might not be appropriate for some 
uses. For example, if the destination of your exported media is a 
multimedia title, you can change the screen dimensions or use another 
codec, such as Cinepak. Alternatively, you can use the QuickTime DV 
codec to create a QuickTime file for further processing in another 
application.

n QuickTime software is installed when you install Avid Xpress DV software. 
You can also install it separately. See “Installing Avid Xpress DV 
Software” on page 24.
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Exporting the Sequence

For complete 
information about 
exporting, see the 
Avid Xpress DV User’s 
Guide or Help.

To create a QuickTime or other digital movie, you need to export the 
sequence.

1. Prepare your final sequence as described in “Preparing the 
Sequence” on page 165.

2. In the Sequences bin, select your final sequence.

3. Choose Export from the File menu.

The Pick Export Settings dialog box appears.

The Export pop-up menu shows the Export settings that are in the 
Settings scroll list. In this example, Untitled is the name of the 
default setting.

The Settings scroll list includes export templates that make the 
export process easier. In this example, you’ll create your own 
template.

4. Click the Customize button.

The Export Settings dialog box appears.
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5. Choose QuickTime Movie from the Export As pop-up menu.

The dialog box changes to show options for exporting QuickTime. 
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For more information 
about these options, 
press the F1 key.

6. In the Save Setting As text box, change the name to QuickTime.

This setting will be saved in the Settings scroll list, and you can 
reuse it later.

7. Select the following options:

• Use Enabled Tracks

• Same as Source

• Video and Audio

The Same as Source option maintains the size and resolution of the 
sequence. This option also informs the system to use the 
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QuickTime DV codec to create the QuickTime movie (see “Using 
the QuickTime DV Codec” on page 174). 

8. Click OK to return to the Pick Export Settings dialog box.

The Export pop-up menu now shows QuickTime.

9. Click OK.

The Export As dialog box appears. This dialog box is similar to 
other Windows Save As dialog boxes.

10. Select a different location for the QuickTime movie. For this 
tutorial, the QuickTime movie requires approximately 220 MB of 
disk space, so pick a drive that has sufficient space. In most cases 
you should pick a drive other than drive C.

11. Click Save.

The Avid Xpress DV system creates the QuickTime movie. For this 
tutorial sequence, the processing takes about 1 minute. 

12. Minimize the Avid Xpress DV window, double-click My 
Computer, and locate the exported QuickTime movie.
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13. Play your movie using the QuickTime player. If QuickTime is 
properly installed, you can play the movie by double-clicking its 
icon. 

Using the default screen dimensions and DV codec creates a large 
QuickTime movie that is best suited for further processing in 
another multimedia development application. To change the 
screen size and other options, select Custom in the Export Settings 
dialog box. For more information, see the Avid Xpress DV User’s 
Guide or Help.

Outputting a Digital Cut to Tape

For information about 
connecting a camera or 
video deck, see 
Appendix A.

Avid Xpress DV provides you with options for outputting your 
sequence to tape. This output is referred to as a digital cut. You can 
output to your DV camera or video deck, or, if you have a transcoder 
connected to the system, to a Betacam, VHS, or other analog video 
deck. You can also output to an audio deck.

About Remote and Local Deck Control

The Digital Cut tool provides you with two options for controlling 
your deck:

• Remote: Allows you to control the deck by using the deck 
controller in the Digital Cut tool. This option provides frame-
accurate control when you record a sequence to tape. To use 
Remote deck control, you need a tape that includes timecode 
information (a prerecorded or blacked tape). For information 
on creating a prerecorded or blacked tape, see the instructions 
for your camera or deck.

• Local: Allows you to manually control the deck by using the 
controls on the deck. This option is useful when you need to 
use non-Avid-controlled decks, such as consumer-grade VHS 
or Hi8, or if you do not have a tape with timecode.
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Changing the Timecode of the Sequence

Your sequence uses timecode that starts with 00;00;00;00 (NTSC drop-
frame timecode) or 00:00:00:00 (PAL timecode). 

n To record a digital cut to an NTSC DV camera or video deck, you need to use 
drop-frame timecode in your sequence. For information about timecode, see 
“About Timecode” on page 85. 

You can change the timecode for the start of the sequence. This change 
prevents problems if you try to record a digital cut starting at or near 
the very beginning of a tape (00;00;00;00). For this tutorial, you’ll 
change the timecode so that the sequence begins to record 30 seconds 
after the start of the tape.

1. Make sure a sequence is loaded in the Composer monitor.

2. Click the Composer monitor.

3. Choose Get Sequence Info from the File menu.

The Sequence Info dialog box appears.
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You can change the 
default starting 
timecode in the General 
Settings dialog box.

4. In the Start text box, edit the timecode so that it reads 00;00;30;00 
(NTSC) or 00:00:30:00 (PAL).

5. Click OK.

The timecode displayed in the Timeline changes to match the new 
starting timecode.

Configuring Your Camera or Video Deck

Before you record your digital cut, you need to select the camera or 
video deck you are using so you can control the camera or video deck 
through the Digital Cut tool. 

1. In the Project window, choose Deck Configuration from the 
Settings scroll list.

The Deck Configuration dialog box appears.
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2. Click the Add Channel button.

The Channel dialog box appears.

Channel refers to the signal path for deck control. If you have 
connected a DV camera or video deck that supports IEEE 1394, 
choose FireWire as the Channel Type and 1394 as the Port from the 
pop-up menus.

3. Click OK.

A message box asks if you want to automatically configure the 
channel.

4. Click No.

The Deck Configuration dialog box now includes a channel.
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5. Click the channel box to select the channel.

A red outline indicates that the channel box is selected.

6. Click the Add Deck button.

The Deck Settings dialog box appears.

Channel
box
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For information about 
all Deck Settings 
options, see the 
Avid Xpress DV User’s 
Guide or press F1 for 
Help.

7. Choose the manufacturer and model of your camera or video deck 
from the Deck Type pop-up menus. If you do not see the 
manufacturer or model, choose Generic from the first pop-up 
menu.

8. Click OK.

The Deck Configuration dialog box now shows the channel and 
the connected camera or video deck.

9. In the Deck Configuration dialog box, make sure the channel box 
is selected (outlined in red) and click the Apply button.

Your camera or video deck is now ready for recording.
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Recording a Digital Cut

Now you’re ready to record your sequence on tape.

1. Make sure your camera or video deck is properly connected (see 
Appendix A) and turned on to the VTR setting.

2. Insert a tape that contains timecode (see “About Remote and 
Local Deck Control” on page 179).

3. Prepare your sequence by making sure you have selected and 
monitored the tracks you want to use (see “Preparing the 
Sequence” on page 165).

4. Choose Digital Cut from the Clip menu.

The Digital Cut tool opens.
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5. Select the tape as follows:

a. If the Select Tape dialog box does not appear automatically, 
click the Tape Name button in the Digital Cut tool.

Enable Track buttons

Deck controls

Deck Selection pop-up menu

Sequence Track buttons Play Digital Cut button Halt Digital Cut button

Timecode text boxes

Tape Name button
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b. Click the New button. 

The name New Tape appears in the dialog box. 

c. Type a name for your tape and press the Enter key on the main 
keyboard.

d. Select the new tape name and click OK.

To get Help for the 
Digital Cut tool, press 
F1 or position the 
pointer on an object, 
click the right mouse 
button, and choose 
What This? from the 
pop-up menu.

6. Use the following settings in the Digital Cut tool:

a. Select the Entire Sequence option.

b. Select the Remote option to control the camera or video deck.

c. Choose Sequence Time from the pop-up menu to start the 
recording at a timecode existing on tape that matches the start 
timecode of the sequence. 

7. Select the video and audio tracks you want represented in the 
digital cut by using the Sequence Track buttons. The selected 
buttons should match the tracks that you selected in your 
sequence. The Video Sequence Track button shows V2, which is 
the top video track selected.

8. Select the video and audio tracks to record on the tape by using 
the Enable Track buttons. They should match the selected 
Sequence Track buttons.

Sequence
Track 
buttons

Enable
Track 
buttons
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9. Click the Play Digital Cut button.

A message box asks you to mount the destination tape in the video 
deck. If you have already inserted a tape, click OK.

The system cues the video deck to the starting timecode of the 
sequence, and then plays and records the digital cut. The playback 
appears in the Client monitor (if one is connected).

To stop the recording at any time, press the space bar. When the 
sequence finishes playing, a message box informs you that the 
digital cut is complete.

10. Click OK.

11. Close the Digital Cut tool.

Next Steps

You’ve generated your final output. The next chapter describes how to 
back up your project. You can continue to the next chapter, or quit this 
session (see “Closing the Project and Quitting the Application” on 
page 68).
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CHAPTER 11

Backing Up and Deleting a 
Project

Now that you’ve completed your sequence and created output, you 
might want to save your work. You can then delete the project to save 
space on your media drive or drives. In this chapter you’ll practice the 
following tasks:

• Backing Up Project Information

• Backing Up Media Files

• Deleting a Project Folder and Media Files

If you have worked on the previous chapters but have quit 
Avid Xpress DV — Start the application, choose your user name and 
the Introducing Avid project, and then click OK. If necessary, open the 
Sequences bin, and then drag your final sequence into the Composer 
monitor.

If you have not worked on the previous chapters — Start the 
application, create a new user, choose the Introducing Avid project, 
and then click OK. Open the Sequences bin, and then drag the 
Introducing Avid sequence into the Composer monitor. 
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Backing Up Project Information

Project information and User settings are contained in folders. You can 
save these folders on a floppy disk or any kind of drive, including a 
network drive. 

The project folder does not include the media. It does include 
information about the sequences, bins, master clips, subclips, effects, 
and other components of the project.

The Introducing Avid project is a small one, so you can copy the 
information onto a floppy disk.

1. Insert a formatted floppy disk into your floppy drive.

2. Minimize the Avid Xpress DV window to view the Windows NT 
desktop.

3. Double-click the My Computer icon and locate the Avid Projects 
folder.

The exact location of this folder depends on your installation. In 
most cases it is located in the Avid\Avid Xpress DV folder on an 
internal hard drive other than drive C.

4. Double-click the Avid Projects folder.

5. Select the folder for your project. The folder has the same name 
that you see in the Open Project window, in this case Introducing 
Avid.

6. Copy the folder to the floppy disk using any Windows NT 
technique. For example:

a. Select the project folder.

b. Choose Copy from the Edit menu.

c. Double-click the My Computer icon and double-click the 
floppy disk.

d. Choose Paste from the Edit menu.
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7. After the folder is copied, label the floppy disk and store it in a 
safe place.

Backing Up Media Files

The OMFI MediaFiles folders on your media drives contain the 
individual media files created when you recorded source material. 
Unlike the smaller Avid Projects and Avid Users folders, these folders 
are too large to back up onto floppy disks.

The media files for the tutorial are stored on the tutorial CD-ROM that 
came with your system, so you don’t need to back them up. For other 
projects, the following are options for backing up media files:

• You can use the Consolidate feature to make copies of selected 
media files on a target hard drive connected to the system. For 
information on consolidating, see the Avid Xpress DV User’s Guide 
or Help.

• You can back up smaller projects to a removable storage device, 
such as a hard drive.

• You can archive larger media files and folders to a network storage 
device.

Deleting a Project Folder and Media Files

If you are finished with the tutorial and you want to create free space 
on your drives, you can delete the project folder and media files. The 
project folder consists of information about the clips and sequences, 
but does not include the media. Media files consist of the recorded 
video and audio data, and are stored on your media drive or drives.
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Deleting a Project Folder 

You can’t delete project information from within the Avid Xpress DV 
application. You need to quit the application and delete the project 
from your Windows NT desktop. 

If you are finished with your project, delete the project information by 
following these steps:

1. Quit the Avid Xpress DV application.

2. Double-click the My Computer icon and locate the Avid Projects 
folder.

The exact location of this folder depends on your installation. In 
most cases it is located in the Avid\Avid Xpress DV folder on an 
internal hard drive other than drive C.

3. Double-click the Avid Projects folder.

4. Select the folder for your project, in this case Introducing Avid.

5. Press the Delete key or drag the folder to the Recycle Bin. 

The Confirm Folder Delete dialog box appears and asks if you are 
sure you want to delete the folder.

6. Click Yes.

7. Empty the Recycle Bin to remove the files from the system.

Deleting Media Files

The most efficient way to delete all media files for a project is by using 
the Media tool. The Media tool is your window to the recorded video 
and audio data files stored on your media drives.

If you are finished with the tutorial, delete the project’s media files by 
following these steps:

1. Start the Avid Xpress DV application and open the project.
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2. Choose Media Tool from the Tools menu.

The Display Media Selection dialog box appears.

3. Select the media drive for your media. To make sure the Media 
tool displays all your media, click the All Drives button.

4. Select the Introducing Avid project.

5. Select all three types of files:

• Master Clips

• Precompute Clips (which are rendered effects)

• Media Files

6. Click OK. 

The Media tool opens. Specific icons indicate the types of media 
files.
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7. Choose Select All from the Edit menu.

All files are highlighted.

8. Press the Delete key.

The Delete Media dialog box appears. The check boxes in the 
dialog box indicate that you have selected all files for deletion.

Precompute 
clip

Master clip

Audio master 
clip

Media file
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9. Click OK.

A dialog box appears and asks if you want to delete the media 
files.

10. Click Delete.

The selected media files are deleted.

11. Quit the application.

Next Steps

Congratulations on completing the Avid Xpress Tutorial! We hope 
you’ve enjoyed this introduction to the Avid editing process. After 
mastering these skills, you can proceed to learn more advanced 
techniques, as described in the Avid Xpress DV User’s Guide, 
Avid Xpress DV Effects Guide, and Help.
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APPENDIX A

Connecting Your Editing 
Equipment

This appendix describes how to connect editing equipment to the 
computer on which the Avid Xpress DV software will run. This 
appendix contains the following topics:

• Connecting the Application Key

• Connecting the External SCSI Drives

• Connecting the Editing Equipment
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Connecting the Application Key

The application key, commonly referred to as a dongle, allows 
Avid Xpress DV software to run on your computer. You must connect 
the application key to the printer port at the rear of the computer. The 
computer system sees the application key when booting. If you 
connect the application key after you boot the system, you must reboot 
the system. You can connect a printer to the port by connecting the 
printer to the female portion of the application key. Figure A-1 shows 
how to connect the application key.

Figure A-1 Application Key Connection

c Be careful that you do not lose the application key. Your 
Avid Xpress DV software does not function without it. If you lose 
your application key, you must purchase another key from Avid at 
the full market cost of your Avid Xpress DV software.

Application key

Female port connection 

Computer

Printer port

for printer
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Connecting the External SCSI Drives

This section explains how to connect external SCSI drives to your 
Ultra2 LVD/SE SCSI board located at the rear of your computer. 
Because the Ultra2 LVD/SE SCSI board has a 68-pin, high-density 
connector, illustrations of SCSI drives show 68-pin, high-density 
connectors. 

n If you purchased drives other than the illustrated ones, use the instructions 
that came with your drives.

This section contains:

• Installation Overview

• Placing the Drives

• Cabling the Drives

• Determining the SCSI IDs

• Setting the SCSI IDs

Installation Overview

Installing external SCSI drives is not very difficult; however, you must 
consider the following: 

• Place the drives near your computer to save space, and position 
the drives so they can’t fall over.

• Cable the drives from your computer to the last drive in the chain, 
and terminate the last drive.

• Determine the SCSI IDs before you physically set them on the 
drive.

• Set the SCSI IDs so the system software and the Avid Xpress DV 
software can access them. 
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Placing the Drives

Placing the external drives is an important part of the installation. 
When you place the external drives, consider the following: 

• Place the drives close to the computer. There is a maximum 
cable-length restriction of 20 feet when you use wide-type drives. 

• Do not place the drives on the floor. They can pick up dust and 
dirt from the floor or carpet.

• When you have more than one external drive, you can stack the 
drives so they take up a minimal amount of desk space. If you use 
more than four drives, consider creating two drive stacks (see 
Figure A-2).

c You should not stack more than four external SCSI drives.

Figure A-2 Placing the External SCSI Drives
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Cabling the Drives

Now cable the SCSI drives to the Ultra2 LVD/SE SCSI board. 
Figure A-3 shows a chain of four SCSI drives.

Figure A-3 Example of a Chain of SCSI Drives

You will need the following to cable a chain of SCSI drives to the 
68-pin, high-density connector on the SCSI board:

• Adapter cable — placed between the SCSI board and the first SCSI 
drive. Where you have placed the computer and where you are 
going to place the first SCSI drive determines the length of the 
adapter cable. 

• Interconnect cable — placed between each SCSI drive in the SCSI 
chain. This cable is the same type of cable as the adapter cable, but 
is usually 15 inches in length. 

n You might need a longer interconnect cable if you are connecting the top drive 
in a stack of four drives to the bottom drive in another stack.

4

4

4

4

Adapter cable 

Interconnect cables 

Terminator

First SCSI drive

Last SCSI drive

to SCSI board
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• LVD terminator — always placed on the last SCSI drive in the 
chain to ensure reliable communication on the SCSI bus. 

Figure A-4 shows an example of an adapter cable and an LVD 
terminator. The cables that ship with the SCSI drives you purchased 
should look similar.

Figure A-4 Cable and Terminator

Adapter cable

LVD terminator
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To cable a chain of SCSI drives to the SCSI board:

1. Locate the adapter cable that goes between the SCSI board and the 
first SCSI drive.

2. Connect one end of the adapter cable to the 68-pin, high-density 
connector on the SCSI board at the rear of the computer (see 
Figure A-5). 

Figure A-5 Connecting the Adapter Cable to the SCSI Board

3. Secure the adapter cable to the SCSI board by using the screws in 
the cable.

4. Connect the other end of the adapter cable to one of the 68-pin 
connectors of the first SCSI drive (see Figure A-6).

SCSI board

Adapter cable

Screws
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Figure A-6 Connecting the Adapter Cable to the First SCSI Drive

5. Secure the adapter cable to the first SCSI drive by using the screws 
in the cable.

6. Locate the interconnect cable that goes between the first and 
second SCSI drives. 

7. Connect one end of the 68-pin, high-density cable to the 68-pin 
connector of the first SCSI drive (see Figure A-7).

4

Adapter cable

Screws

First SCSI drive



204

Figure A-7 Connecting the Interconnect Cable Between SCSI 
Drives

8. Connect the other end of the 68-pin, high-density cable to the 
68-pin connector of the second SCSI drive.

9. Secure both ends of the cable to the drives by using the screws in 
the cable.

10. Repeat step 6 to step 9 for the remaining SCSI drives (up to a 
maximum of 13 drives).

4

4

Interconnect cable

First SCSI drive

Second SCSI drive

68-pin connector

68-pin connector

Adapter cable
from SCSI board
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11. Locate the LVD terminator for the SCSI chain.

12. Connect the terminator to the 68-pin connector on the last SCSI 
drive in the SCSI chain (see Figure A-8).

Figure A-8 Connecting the LVD Terminator

13. Secure the terminator to the SCSI drive by using the screws on the 
terminator.

You should now determine the SCSI IDs for the SCSI drives that you 
have connected to the SCSI board.

4

4
Terminator

Last SCSI drive

Screws
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Determining the SCSI IDs

For each SCSI drive you connect to the computer, you must assign a 
SCSI ID so the Avid Xpress DV software can find and access the drive. 
When you are setting the SCSI IDs, remember the following:

• Each PCI-based SCSI bus has its own set of unique SCSI IDs from 
0 through 6 and 8 through 15.

• SCSI IDs 0 and 1 are not available for use by external drives. The 
two internal SCSI drives use those IDs (an internal drive can also 
use SCSI ID 2).

• SCSI ID 7 cannot be used by external drives. SCSI ID 7 is used by 
the SCSI accelerator board.

• You cannot have two SCSI drives with the same SCSI ID on the 
same SCSI bus.

Avid recommends that you set the SCSI IDs for the devices on each 
SCSI bus in sequential order; that is, starting with the device attached 
closest to the computer and assigning it ID 3 (see Figure A-9). 

n If your internal SCSI drives have SCSI IDs of 0 and 1, you can set the 
starting SCSI ID of your external drives at 2.

Figure A-9 Setting the SCSI IDs

ID 7SCSI board 

Computer

External SCSI drives

Terminator

SCSI cablesID 3

ID 4

ID 5

ID 6ID 0

ID

Internal
SCSI drives

 
1 or 2
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Setting the SCSI IDs

The following illustrations show how to set a SCSI ID by using a 
wide-type SCSI drive with switches and connections at the rear of the 
drives. If the drives you purchased do not look like the drives shown 
in the illustrations, use the installation instructions that came with the 
drives you purchased. 

n If you are using the SCSI installation instructions that came with your 
drives, you still need to use the information in “Determining the SCSI 
IDs” on page 206. 

To set a SCSI ID:

1. Locate the SCSI ID switch on the rear of the SCSI drive (see 
Figure A-10).

Figure A-10 SCSI ID Switch Location

n Be sure the drive power is off when changing the SCSI ID switch. When the 
drive is turned on, it will read the new SCSI ID.

2. Set the SCSI ID to an available SCSI ID on the SCSI bus by using 
the SCSI ID switch (see Figure A-11). The current SCSI ID number 
appears in the window in the middle of the switch. 

• Press the top button to decrement the SCSI ID. 

• Press the bottom button to increment the SCSI ID. 

2

SCSI ID switch
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Figure A-11 SCSI ID Switch

There are two SCSI ID switch versions used with the SCSI drives. One 
version uses the numbers 0 through 15, and the other version uses the 
numbers 0 through 9 and the letters A through F. Use Table A-1 to 
associate the letters A through F with a SCSI ID number.

2
-

+

Decrement ID

Increment ID

Current SCSI ID

Table A-1 Numbers Associated with SCSI Switch Letters

Switch Letter SCSI ID Number

A 10

B 11

C 12

D 13

E 14

F 15



209

Connecting the Editing Equipment

Make sure that you have completed the setup information provided 
with your computer. This information provides instructions for setting 
up your computer, and attaching the monitor, keyboard, and mouse. 

c Make sure that your computer is turned off before you connect the 
rest of the equipment.

Your editing equipment might be a camera, a digital video deck, or an 
analog video deck connected to a transcoder. This section provides 
illustrations and instructions to help you connect the cables between 
the editing equipment and the computer. 

n The cameras, video decks, and transcoders in the illustrations represent the 
type of equipment supported by Avid Xpress DV. Therefore, the illustrations 
show cables that came with the camera, transcoder, video deck, or capture 
board. You can also purchase other cables from a local audio or video store.

This section is divided into five parts:

• Overview of the Hardware Connections

• Cables Needed to Connect the Equipment

• Connecting a Digital Video Deck or Camera to the Computer

• Connecting an Analog Video Deck to the Computer

• Controlling an Analog Video Deck

n For a list of supported cameras, transcoders, and video decks, check the 
Customer Service section of the Avid Web site at www.avid.com.



210

Overview of the Hardware Connections

The type of data (digital or analog) you transfer between the editing 
equipment and the computer is used for different purposes by 
Avid Xpress DV. You should think of the data being transferred in 
terms of how it is being used. 

• Digital video and digital audio (DV) — used for editing 
purposes. These signals come from either a digital video deck, a 
digital camera, or a transcoder connected to an analog video deck 
using a 4-pin to 4-pin IEEE 1394 cable (see Figure A-12) attached 
to the capture board plugged into your computer. As an output, 
the DV signals can be recorded and used to control a digital video 
deck or camera.

• Analog video — not used for editing purposes. These signals 
come from a digital video deck, camera, or transcoder to the 
capture board. The capture board then loops the analog video to 
an optional Client monitor. This process allows you to monitor the 
video as you record the data or output the data. There are two 
forms of analog data (see Figure A-12):

- Composite video using RCA® connectors 

- S-Video using S-Video connectors 

n The analog connection is also used when your camera or transcoder is 
connected to the computer and you play a clip from the Avid Xpress DV 
software. See Table A-2, step 2 for more information.

• Analog audio — not used for editing purposes. The analog audio 
output of a digital video deck, camera, or a transcoder connects to 
the audio input at the rear of the computer. You can hear the 
analog audio through the speakers during the record process or 
when you play back the clips using the software.
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Cables Needed to Connect the Equipment

You need cables to connect the computer to the camera, digital video 
deck, or transcoder used with an analog video deck. You receive some 
or all of these cables when you purchase most digital video decks, 
digital cameras, or transcoders. Because Avid Xpress DV supports 
many digital cameras, the number and type of cables you receive 
cannot be determined. Given this fact, this section describes:

• Cables that ship with the Avid Xpress DV software and 
computer, and how to connect them to either a camera or 
transcoder

• Other cables, and what they are used for, in case you buy an 
optional transcoder, Client monitor, or analog video deck

Most of the cables have different colors that define what the cable is 
used for. Normally, you plug the cable into the same color connector 
on your camera, digital video deck, or transcoder. The colors and their 
uses are listed below:

• Yellow — used for video

• White — used for audio as one channel of a stereo pair or for 
mono audio

• Red — used for audio as one channel of a stereo pair

n The cameras, video decks, and transcoders in the illustrations represent the 
type of equipment supported by Avid Xpress DV. Therefore, the illustrations 
show cables that came with the camera, transcoder, video deck, or capture 
board. You can also purchase other cables from a local audio or video store.

Cables Shipped with the Computer

Figure A-12 shows the cables shipped with the computer and their 
functions.
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Figure A-12 Computer Cables

Optional Cables

Depending on the options you purchased, you might need to 
buy the following cables separately:

• RS-232 to RS-422 cable from an RS-232 serial port on the 
computer to the RS-422 remote port of an analog video deck. You 
might need an RS-232 to RS-422 adapter and two serial cables to 
perform this remote control function (see “Controlling an Analog 
Video Deck” on page 219).

• Composite RCA cable or S-Video cable from the capture board to 
the Client monitor (if not provided with your camera).

• Various cables to connect the analog video deck to the transcoder.

The manuals provided with the transcoder, Client monitor, and video 
deck explain how to connect cables to these components.

Male audio input Y cable — Analog audio from the camera, transcoder, 

Cable Function

S-Video — S-Video In/Out from the camera, transcoder, or digital video deck

Male RCA — Composite video In/Out from the camera, transcoder, or 

Female RCA Y cable — Adapter cable for male RCA connectors from 

DV (4-pin to 4-pin IEEE 1394) — Digital audio and video In/Out from the 

digital video deck to the input of the capture board 

or digital video deck to the miniaudio input

the camera or transcoder to the miniaudio 
input of the system 

camera, transcoder, or digital video deck

to the input of the capture board

 of the system 

to the capture board.
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Connecting a Digital Video Deck or Camera to the Computer

To connect the digital video deck or camera to the computer, you need 
to have the cables from your digital video deck or camera and the 
capture board available. Then, follow the steps that are shown in 
Figure A-13 and explained in Table A-2. Make sure to connect both 
the DV and analog cables.

Figure A-13 Connecting the Digital Video Deck or Camera

DV

Out2

Out1

In2

In1

S-video

Video

Audio 1 (Mono)

Audio 2

DV Step 1

Step 2a

Step 3a

Step 4

Computer

Speakers connected 

Step 2b

during system setup

Step 3b

Audio In

Audio Out

Representative connections
of a digital deck or camera

Capture board

Client monitor
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Table A-2 Connecting the Digital Video Deck or Camera

Step Description

1 Connect the DV cable from the 
digital deck or camera to the 
capture board. 

Connect a 4-pin to 4-pin DV-to-DV cable from the 
digital deck or camera to the DV port on the capture 
board. This provides DV video and audio to and from 
the capture board. This cable must remain connected to 
use the hardware codec (compressor/decompressor) in 
the camera for display during editing. 

2 Connect the analog video from the 
digital deck or camera to the 
capture board. 

Connect the analog signal with either an RCA cable 
(step 2a) or an S-Video cable (step 2b). Perform step 2a 
or step 2b, not both.

2a Connect an RCA-to-RCA cable 
from the camera to the In1 port on 
the capture board.

Provides a composite analog signal from the hardware 
codec of the camera to the In1 port on the capture 
board. The signal is looped to the Out1 port and used as 
a composite output of the capture board to the Client 
monitor.

The composite signal from the camera is also used 
when you play a clip in the Source pop-up monitor or 
Composer monitor. The data from the clip is sent as 
output through the DV cable to the camera. The 
camera’s hardware codec sends the signal as composite 
video through the RCA cable to the In1 port of the 
capture board. This signal is then sent to the monitors.

2b Connect an S-Video to S-Video 
cable from the camera to the In2 
port on the capture board.

Same as step 2a except the signal uses the In2 and Out2 
ports.

3 

n

Connect the capture board to the 
optional Client monitor. 

The Client monitor and its cables 
do not ship with the computer and 
must be purchased separately.

Connect the Client monitor with either an RCA cable 
(step 3a) or S-Video cable (step 3b). 

Perform step 3a if you used an RCA cable in step 2 or 
perform step 3b if you used an S-Video cable in step 2.
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3a Connect an RCA cable to the Out1 
port on the capture board. 

Attach the other end of the cable 
to the Client monitor (this end of 
the cable needs a connector to 
match the input of the Client 
monitor). 

Provides composite analog video from the Out1 port, 
looped from the In1 port connection, to the Client 
monitor. You can see the incoming video during the 
record process and when you play a clip, as explained 
in step 2a.

3b Connect a cable with an S-Video 
connector to the Out2 port on the 
capture board.

Attach the other end of the cable 
to the Client monitor (this end of 
the cable needs a connector to 
match the input of the Client 
monitor). 

Same as step 3a except the signal uses the In2 and Out2 
ports.

4

n

Connect the Audio Out of your 
camera or deck to the Audio In at 
the rear of the computer. 

Depending on the digital deck or 
camera you have purchased, your 
cables might be different than those 
shown in Figure A-13.

The example shown in 
Figure A-13 uses two male RCA 
to male RCA cables attached to a 
female RCA Y cable connected to 
the Audio In at the rear of the 
computer. 

Provides audio output to the speakers during the 
record process or when you are playing a clip.

You should have already connected the optional 
speakers during the initial setup of the computer.

Table A-2 Connecting the Digital Video Deck or Camera (Continued)

Step Description
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Connecting an Analog Video Deck to the Computer

An analog video deck connects to a transcoder, and the transcoder 
connects to the computer. You need the cables from your camera and 
the capture board available, and then follow the steps that are shown 
in Figure A-14 and explained in Table A-3. 

Figure A-14 Connecting an Analog Video Deck 

IN
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S-VIDEO
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Step 1

Step 2

Step 3a

Step 3b Step 4a

Step 4b

Step 5

Speakers connected 
during system setupAudio Out

Audio In

Capture board

Client monitor

Representative connections
of a transcoder

Computer
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Table A-3 Connecting an Analog Video Deck 

Step Description

1 Connect the video and audio 
cables from an analog video 
deck to the input of the 
transcoder. 

Provides an analog signal to be recorded and used as 
DV data. It also allows the composite video 
signal and analog audio signal to be sent from the 
transcoder back to the deck when you output the edited 
file.

2 Connect the DV cable from the 
transcoder to the capture 
board.

n

Connect a 4-pin to 4-pin DV-to-DV cable from the 
transcoder to the DV port on the capture board. This 
provides DV video and audio to and from the capture 
board. This cable must remain connected to use the 
hardware codec (compressor/decompressor) in the 
transcoder for display during editing.

If your transcoder has a 6-pin output, you need a 6-pin 
to 4-pin cable.

3 Connect the analog video from 
the transcoder to the capture 
board. 

Connect the analog signal with either an RCA cable 
(step 3a) or an S-Video cable (step 3b). Perform step 3a 
or step 3b, not both.

3a Connect an RCA-to-RCA cable 
from the transcoder to the In1 
port on the capture board.

Provides a composite analog signal from the hardware 
codec of the transcoder to the In1 port on the capture 
board. The signal is looped to the Out1 port and used as 
a composite output of the capture board to the Client 
monitor.

The composite signal from the transcoder is also used 
when you play a clip in the Source pop-up monitor or 
Composer monitor. The data from the clip is sent as 
output through the DV cable to the transcoder. The 
transcoder’s hardware codec sends the signal as 
composite video through the RCA cable to the In1 port 
of the capture board. This signal is then sent to the 
monitors as a VGA overlay.
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3b Connect an S-Video to S-Video 
cable from the transcoder to 
the In2 port on the capture 
board.

Same as step 3a except the signal uses the In2 and Out2 
ports.

4

n

Connect the Client monitor to 
the capture board.

The Client monitor and its 
cables do not ship with the 
computer and must be 
purchased separately. 

Connect the Client monitor with either an RCA cable 
(step 4a) or S-Video cable (step 4b). 

Perform step 4a if you used an RCA cable in step 3 or 
perform step 4b if you used an S-Video cable in step 3.

4a Connect a cable with an RCA 
connector to the Out1 port on 
the capture board. 

Attach the other end of the 
cable to the Client monitor 
(this end of the cable needs a 
connector to match the input 
of the Client monitor). 

Provides composite analog video from the Out1 port, 
looped from the In1 port connection, to the Client 
monitor. You can see the incoming video during the 
record process and when you play a clip, as explained 
in step 3a.

4b Connect a cable with an 
S-Video connector to the Out2 
port on the capture board.

Attach the other end of the 
cable to the Client monitor 
(this end of the cable needs a 
connector to match the input 
of the Client monitor). 

Same as step 4a except the signal uses the In2 and Out2 
ports.

You should have already connected the optional 
speakers during the initial setup of the computer.

Table A-3 Connecting an Analog Video Deck  (Continued)

Step Description
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Controlling an Analog Video Deck

Your Avid Xpress DV software provides analog video deck control 
through a remote serial control connector, which is available on most 
analog video decks. You can control a single analog video deck using 
an optional RS-232 to RS-422 serial cable or an adapter kit. Although 
an adapter kit must be purchased separately, the following procedure 
explains how to connect a sample adapter kit between your 
computer and an analog video deck using the following:

• An RS-232 to RS-422 serial adapter

• Two serial cables with 9-pin male connectors at both ends

5

n

Connect the Audio Out of your 
transcoder to Audio In at the 
rear of the computer. You can 
use the cables that came with 
your transcoder.

Depending on the transcoder 
you have purchased, your 
cables might be different than 
those shown in Figure A-14.

The example shown in 
Figure A-14 uses two male 
RCA to male RCA cables 
attached to a female RCA Y 
cable connected to the Audio In 
at the rear of the computer. 

Provides audio output to the speakers during the 
record process or when you are playing a clip.

Table A-3 Connecting an Analog Video Deck  (Continued)

Step Description
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To connect a single deck to your computer:

1. Purchase an adapter kit.

2. Attach one end of the first 9-pin cable to the end of the serial 
adapter labeled RS-232 (see Figure A-15). 

3. Attach the other end of the first 9-pin cable to the serial port of the 
computer.

Figure A-15 Analog Video Deck Control Cabling

4. Attach one end of the second 9-pin cable to the end of the serial 
adapter labeled RS-422. 

5. Attach the other end of the second 9-pin cable to the remote serial 
port of the analog video deck.

To computer

Serial adapter RS-232 connectionRS-422 connection

To analog
video deck
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